Appendix A

Guide to Using Microsoft Project 2002

Opening Case 455
Introduction 456

New Features of Microsoft Project 2002 457

Overview of Microsoft Project 2002 460
  Starting Project 2002 and the Project Help Window 460
  Main Screen Elements 465
  Project 2002 Views 470
  Project 2002 Filters 474

Project Scope Management 477
  Creating a New Project File 477
  Developing a Work Breakdown Structure 479
  Saving Project Files With or Without a Baseline 483

Project Time Management 485
  Entering Task Durations 486
  Establishing Task Dependencies 491
  Changing Task Dependency Types and Adding Lead or Lag Time 494
  Gantt Charts 497
  Network Diagrams 499
  Critical Path Analysis 502

Project Cost Management 504
  Fixed and Variable Cost Estimates 504
  Assigning Resources to Tasks 508
  Baseline Plan, Actual Costs, and Actual Times 516
  Earned Value Management 521

Project Human Resource Management 523
  Resource Calendars 523
  Resource Histograms 525
  Resource Leveling 529
OPENING CASE

Kathy Nelson was managing a project to develop a Project Tracking database for all of her firm’s projects. She asked one of her assistants, Terry Dunlay, to work with her in using Microsoft Project 2002 to help manage the project. Kathy was familiar with using previous versions of Microsoft Project, and Terry had never used any type of project management software before. Terry had been out of the job market for a few years, but she did use word-processing software and e-mail almost daily. She had also built some very simple spreadsheets to keep track of her family’s finances.

Kathy suggested that Terry familiarize herself with Project 2002 by reading information on Microsoft’s Web site, working through the online tutorials and documentation that came with the software, opening several template files, and just playing around with the software. Kathy also suggested that Terry read a good textbook on project management so she would understand some of the concepts behind the software. Kathy knew from experience that project management software was very confusing if you did not know what it meant to create a work breakdown structure (WBS), link tasks, assign resources, view Gantt charts and network diagrams, set a baseline, enter actuals, and so on. Once Terry was ready, Kathy would help her enter information regarding the project and use this powerful software to help manage the Project Tracking Database project and future projects.
This appendix provides a concise guide to using Microsoft Project 2002 to assist in performing project management. The CD-ROM in the back of this text includes a 120-day trial version of Project 2002 Standard. You can also download evaluation copies of various Microsoft Project products from www.microsoft.com/project. Project 2002 can help users manage different aspects of all nine project management knowledge areas. Most users, however, focus on using Project 2002 to assist with scope, time, cost, human resource, and communications management. This appendix uses these project management knowledge areas as the context for learning how to use Project 2002.

As described in Chapter 1, Introduction to Project Management, hundreds of project management software products are available today. Microsoft Project is the clear market leader among midrange applications. A 1998 survey of 1,000 project managers showed that Microsoft Project was by far the most widely used computerized project management tool. When asked to list three project management tools they were currently using or had used within the past three years, 48 percent of the 159 survey respondents listed Microsoft Project. Only 13.8 percent of respondents mentioned the second most-listed tool, Primavera Project Planner. The third most-listed tool was Microsoft Excel, the only one of the ten tools listed that is not categorized as a project management software tool. Survey respondents used Microsoft Project for project control and tracking, detailed scheduling, early project planning, communication, reporting, high-level planning, Gantt chart and Critical Path Method (CPM) development, and Program Evaluation and Review Technique (PERT). Respondents used Excel for budgeting, cost analysis, variance analysis, tracking and reporting, and creating WBSs. In a December 2001 press release, the pci group and the American Productivity and Quality Council (APQC) reported that 88 percent of the companies in their study reported using scheduling software, with more than 65 percent using Microsoft Project. An August 2002 software review stated that Microsoft Project has dominated the standalone desktop market for years, but up until 2002 Microsoft had ceded the enterprise market to other vendors like Welcom and Primavera. Enterprise project management software, as mentioned in Chapter 1, includes high-end tools that provide robust capabilities to handle very large projects, dispersed workgroups, and enterprise functions that summarize and combine individual project information to provide an enterprise view of all projects. Microsoft entered the enterprise market with its Solution for Enterprise Project Management, which consists of Project 2002 combined with Project Server 2002.

Even with its popularity, however, Microsoft Project is not nearly as widespread in its use as other Microsoft products such as Word or Excel. At Inmark Communications’ Project World Conference in December 1998, Microsoft issued a press release stating that it had surpassed the three-millionth-customer mark for Microsoft Project products. Customers of Word or Excel are much higher—well over 100 million. In January 2000, Microsoft announced that revenues from Microsoft Project had grown to more than $100 million and that it planned to develop and enhance applications.

Before being able to use Project 2002 effectively, you must understand the fundamental concepts of project management. Therefore, to master the proper use of Project 2002, use this guide in conjunction with the main text. Each of the chapters on the project management knowledge areas (Chapters 4 through 12) includes a section describing how software, including Project 2002, can assist in managing that area.

NEW FEATURES OF MICROSOFT PROJECT 2002

Because there have been several previous versions of Microsoft Project, it is useful to understand some of the new capabilities of Project 2002, especially if you are working with people who are upgrading from a previous version.

One of the most significant differences between Project 2002 and Project 2000 is that Microsoft now provides two different versions of Project 2002—Microsoft Project Standard 2002 and Microsoft Solution for Enterprise Project Management.

1. Microsoft Project Standard 2002 is most similar to previous versions of Project and is intended for individual desktop usage, although it does include one Client Access License (CAL) for connection to Project Server 2002 via the Web, if available. This appendix focuses on using Microsoft Project Standard 2002.

2. The Microsoft Solution for Enterprise Project Management version includes several components, such as Microsoft Project Professional 2002, Microsoft Project Server 2002 (which includes Microsoft Project Web Access), and Microsoft Project Server Client Access. Project Server 2002 also requires SQL Server. Microsoft SQL Server is a complete database and analysis software package that helps organizations develop enterprise applications. Organizations should develop and apply many standards, templates, codes, and procedures before using the enterprise version of Project 2002 to make the best use of its capabilities.


5 Business Wire, “Pacific Edge Software Appoints Jim Dunnigan as Vice President of Marketing” (1/19/00).
Microsoft’s Web site lists details on these different versions (www.microsoft.com/project). Figure A-1 provides an overview of using either Project Standard 2002 or Solution for Enterprise Project Management.

**Microsoft Project Standard 2002**

- **Project 2002 Standard**
  - Desktop application
  - For individual business and project managers
  - Most similar to Project 2000
  - Includes one Client Access License (CAL)

**Microsoft Solution for Enterprise Project Management**

- **Project Web Access**
  - Project team members and executives use CALs to access project information
- **Project Professional 2002**
  - Project managers use on their desktops, provides full functionality

**Project Server 2002**

- Server software, central location for project-related information, comes with five CALs
- Required for enterprise project management functionality

*Figure A-1. Microsoft Project Standard 2002 Versus Microsoft Solution for Enterprise Project Management*

There are also several new features available in Project 2002. Both versions of Project 2002 include the following new features:

- New interactive help tool called the Project Guide
- Microsoft Office XP interface
- Smart tags
- Improved integration with Microsoft Excel and Outlook
- Resource availability graphs
- XML file format
The Microsoft Solution for Enterprise Project Management also includes the following features:

- Enterprise resource pool
- Skill-based resource assignment and replacement
- Improved e-mail notifications and Web-based timesheets and status reports
- Document library using Microsoft SharePoint Team Services
- Issue tracking database
- Project portfolio views
- Modeling and scenario analysis tools
- Real-time reporting
- Enterprise codes, custom fields, and templates
- Project data security layer
- Load balancing and clustering

The steps in this appendix assume you are using Project 2002 Standard, running Windows 2000 or XP, and are familiar with other Windows-based applications. The screen shots were taken using Windows 2000 and Project 2002 Standard, and they will help you check your work. You can also check your work against the solution files that are available for download from the companion Web site for this text (www.course.com/mis/schwalbe) or from your instructor.

Project 2002 supports many features that help you to perform as an effective project manager. You will learn how to take advantage of these features as you work through this appendix, which uses a fictitious information technology project—the Project Tracking Database—to illustrate how to use the software. Each section of the appendix includes hands-on activities for you to work through. To complete the hands-on activities in the appendix, you will need to create a Data Disk or copy files to a location on your hard drive or network drive. If you are making your own Data Disk, you will need a blank, formatted high-density disk. You will need to copy a set of files from a file server or from the companion Web site for this text (www.course.com/mis/schwalbe). When you begin each set of steps, make sure you are using the correct file from your Data Disk, hard drive, or network drive. You should have the following files before you begin your work:

- Software Development.mpt
- resource.mpp
- kickoffmeeting.doc
In addition, you will create the following files from scratch as you work through the steps. After you create the following files, you will need to save each file:

- scope.mpp
- time.mpp
- tracking.mpp
- baseline.mpp
- level.mpp
- taskinfo.html

For further practice, complete the exercises at the end of this appendix. The running cases in Appendix C and some of the exercises and Minicases in other chapters also provide questions involving Project 2002.

Now that you understand project management concepts and the basic project management terminology, you will learn how to start Project 2002, review the Help facility and a template file, and begin to plan the Project Tracking Database project.

OVERVIEW OF MICROSOFT PROJECT 2002

The first step to mastering Project 2002 is to become familiar with the Help facility and online tutorials, major screen elements, views, and filters. This section describes each of these features.

Starting Project 2002 and the Project Help Window

To start Microsoft Project 2002:

1. Open Project 2002. Click Start on the Windows taskbar, select Programs (or All Programs if using Windows XP), and then click Microsoft Project. Alternatively, a shortcut or icon might be available on the desktop; in this case, double-click the icon to start the software.

2. Close the New Project Task pane. Click the Close button in the upper-right corner of the New Project Task pane. The Project Guide window will display along with a blank project screen, as shown in Figure A-2.
If the View bar is not open, select View from the Menu bar, and then select View bar.

3. **Maximize Project 2002.** If the Project 2002 program window does not fill the entire screen as shown in Figure A-2, click the Maximize button in the upper-right corner of the program window.

Do not worry if your toolbars or other screen elements look slightly different from Figure A-2. Focus on the Project 2002 screen and the Project Guide window.

Project 2002 is now running and ready to use. Notice some of the elements of the Project 2002 screen. The default view is the Gantt Chart view. You can access other views by clicking on each icon in the View bar. When Project 2002 opens, the Project Guide window automatically opens, as shown in Figure A-2.
You can change this option and other options by selecting Options from the Tools menu, as shown in Figure A-3. The Project Guide window helps you learn Project 2002 by providing instructions for completing various steps in building a Project 2002 file.

![Display Project Guide](image)

Figure A-3. Displaying the Project Guide in the Options Dialog Box

You can also display a Project Guide toolbar or other toolbars, as desired, by selecting them under Toolbars from the View menu, as shown in Figure A-4. To close the Project Guide window, click the Close button in the Project Guide window.
Figure A-4. Displaying the Project Guide and Other Toolbars from the View Menu

In addition to using the Project Guide window, you can access other information to help you learn how to use Project 2002 under the Help menu. Figure A-5 displays the Help menu options available, and Figure A-6 provides a description of each option.

Figure A-5. Project 2002 Help Menu Options
Microsoft realizes that Project 2002 can take some time to learn and provides a number of resources on its Web site. Select Office on the Web from the Project 2002 Help menu to go to Microsoft’s Web site for Office products. Microsoft’s Web site for Project 2002 (www.microsoft.com/project) provides files for users to download, case studies, articles, and other useful materials.

Within Project 2002, the Office Assistant helps answer questions as they arise. You can access the Office Assistant at any time by selecting Microsoft Project Help from the Help menu. You can also press F1 or click the Office Assistant icon.
on the Standard toolbar. As in other Microsoft applications, the Office Assistant allows you to type a question and search for related information. You can also hide the Office Assistant from the Help menu if you no longer want it to appear on your screen. Feel free to experiment with the various Help tools.

**Main Screen Elements**

Figure A-7 shows the Project 2002 main screen after closing the Project Guide window. The Project 2002 default main screen, called the Gantt Chart view, has three parts: a Gantt chart, an Entry table, and the View bar. At the top of the main screen, the menu bar and toolbar are similar to those in other Windows applications. Note that the order and appearance of icons on your toolbar may vary from those shown in Figure A-7, depending on the features you are using. You can display the toolbar in one row or two, and icons often change according to which ones you use. Figure A-7 shows several commonly used icons, such as the Link Tasks icon, Zoom In icon, and Indent icon. Below the toolbar is the Entry bar, which displays entries you make in the Entry table, located right below the Entry text box. The Gantt chart appears on the right of the split bar, which separates the Entry table and the Gantt chart. Use the Entry table to enter WBS task information. The column to the left of the Task Name column is the Indicators column. The Indicators column displays indicators or symbols related to items associated with each task, such as task notes or hyperlinks to other files.
Many features in Project 2002 are similar to features in other Windows applications. For example, to collapse or expand tasks, click the appropriate symbols to the left of the task name. To access shortcut items, right-click in either the Entry table area or the Gantt chart. Many of the Entry table operations in Project 2002 are very similar to operations in Excel. For example, to adjust a column width, click and drag or double-click between the column heading titles.

If you select another view and want to return to the Gantt Chart view, select Gantt Chart from the expanded View bar on the left of the screen or select View from the menu bar, and click Gantt Chart, as shown in Figure A-8. If the table on the left appears to be different, select View, point to Table: Entry, and then click Entry to return to the default Entry table view.

Figure A-8. Project 2002 View Menu Options

Notice the split bar that separates the Entry table from the Gantt chart. When you move the mouse over the split bar, your cursor changes to the resize pointer. Clicking and dragging the split bar to the right reveals other task information in the Entry table, including duration, start and finish dates, predecessors, and resource names.
To adjust Project 2002 screen elements:

1. *Open a new template file.* Click **File** on the menu bar, and then click **New.** Click the **General Templates** link below **New from Template** in the New Project Task pane, as shown in Figure A-9.

![Figure A-9. Opening a Template File](image)

After you open template files, those filenames will appear on your screen under the New from Template section. For example, Figure A-9 shows that the template files for Project Office and Home Move were recently accessed on this user’s screen.

2. *Open the Software Development template file.* Click the **Project Templates** tab in the Templates dialog box, scroll down to find the file named Software Development, and then double-click that file’s icon.
You may be prompted to install the template file. If you cannot find the Software Development file, you can download it from the companion Web site for this text.

3. **Close the New Project Task pane.** Click the **Close** button to close the New Project Task pane. Your screen should resemble Figure A-10.

![Figure A-10. Software Development Template File](image)

4. **Adjust the timescale.** Click the **Zoom Out** button on the toolbar twice to display the timescale in years. If you cannot find the Zoom Out button, you can add it to the Standard toolbar by clicking the **Toolbar options** button.

5. **Select Outline Level 1 to display WBS level 1 tasks.** Click the **Show** button’s drop-down arrow on the toolbar, and then click **Outline Level 1**. Your screen should resemble Figure A-11 as you select Outline Level 1. Notice that only the level 1 WBS items display in the Entry table after you select Outline Level 1, and the timescale shows years. The black bars on the Gantt chart represent the summary tasks.
6. **Widen the Task Name column.** To make all the text display in the Task Name column, move the cursor over the right-column gridline in the Task Name header until you see the resize pointer, then double-click the left mouse button to automatically resize the column width to show all the text.

7. **Move the split bar to reveal more Entry table columns.** Move the split bar to the right to reveal the entire Duration column.

8. **Expand a task.** Click the expand symbol to the left of Task 7, Analysis/Software Requirements. Your screen should resemble Figure A-12.
Project 2002 Views

In Project 2002, there are many ways to display project information. These displays are called views. Several views discussed in the main text are on the default View bar: Gantt Chart, Network Diagram, Tracking Gantt Chart, and Resource Graph. Other views include Calendar, Task Usage, Resource Sheet, Resource Usage, and an option to display More Views. These different views allow you to examine project information in different ways, which helps you analyze and understand what is happening on your project.

To the left of the Entry table is the View bar. Instead of using commands on the View menu to change views, you can click icons on the View bar. To save screen space, you can hide the View bar by selecting View from the menu bar and deselecting View Bar. When the View bar is not visible, a blue line appears to the far left of the main screen. When you right-click this blue line, a shortcut menu appears, which gives you quick access to the other views.

The View menu also provides access to different tables and reports that display information in a variety of ways. Some tables that you can access from the View menu include Schedule, Cost, Tracking, and Earned Value. Some reports
you can access from the View menu include Overview, Current Activities, Costs, Assignments, and Workload.

Some Project 2002 views, such as the Chart views, present a broad look at the entire project, whereas others, such as the Form views, focus on specific pieces of information about each task. Three main categories of views are available:

- **Graphical**: A chart or graphical representation of data using bars, boxes, lines, and images.
- **Task Sheet or Table**: A spreadsheet-like representation of data in which each task appears as a new row, and each piece of information about the task is represented by a column. Different tables are applied to a task sheet to display different kinds of information.
- **Form**: A specific view of information for one task. Forms are used to focus on the details of one task.

Table A-1 describes some of the predesigned views within each category that Project 2002 provides to help you display the project or task information that you need.

**Table A-1: Common Project 2002 Views**

<table>
<thead>
<tr>
<th>Category of View</th>
<th>View Name</th>
<th>Description of View</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graphical</strong></td>
<td>Gantt Chart</td>
<td>Standard format for displaying project schedule information that lists project tasks and their corresponding start and finish dates in a calendar format. Shows each task as a horizontal bar with the length and position corresponding to the timescale at the top of the Gantt chart.</td>
</tr>
<tr>
<td></td>
<td>Network Diagram</td>
<td>Schematic display of the logical relationships or sequencing of project activities. Shows each task as a box with linking lines between tasks to show sequencing. Critical tasks appear in red.</td>
</tr>
<tr>
<td><strong>Task Sheet or Table</strong></td>
<td>Entry Table</td>
<td>Default table view showing columns for the Task Name and Duration. By revealing more of the Entry table, you can enter start and end dates, predecessors, and resource names.</td>
</tr>
<tr>
<td></td>
<td>Schedule Table</td>
<td>Displays columns for Task Name, Start, Finish, Late Start, Late Finish, Free Slack, and Total Slack.</td>
</tr>
<tr>
<td></td>
<td>Cost Table</td>
<td>Displays columns for Task Name, Fixed Cost, Fixed Cost Accrual, Total Cost, Baseline, Variance, Actual, and Remaining.</td>
</tr>
<tr>
<td></td>
<td>Tracking Table</td>
<td>Displays columns for Task Name, Actual Start, Actual Finish, % Complete, Actual Duration, Remaining Duration, Actual Cost, and Actual Work.</td>
</tr>
<tr>
<td></td>
<td>Earned Value</td>
<td>Displays columns for Task Name, BCWS, BCWP, ACWP, SV, CV, EAC, BAC, and VAC. See Chapter 6, Project Cost Management, for descriptions of these earned value terms.</td>
</tr>
</tbody>
</table>
Table A-1: Common Project 2002 Views (continued)

<table>
<thead>
<tr>
<th>CATEGORY OF VIEW</th>
<th>VIEW NAME</th>
<th>DESCRIPTION OF VIEW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form</td>
<td>Task Details Form</td>
<td>Displays detailed information about a single task in one window.</td>
</tr>
<tr>
<td></td>
<td>Task Name Form</td>
<td>Displays columns for the Task Name, Resources, and Predecessors for a single task.</td>
</tr>
</tbody>
</table>

Next, you will use the Software Development template file to access and explore some of the views available in Project 2002. As mentioned earlier, you can configure the toolbars and icons in different ways, as with other Office XP products. When you first start Project 2002, the menus and toolbars display basic commands and buttons. As you work with Project 2002, the commands and buttons that you use most often are stored as personalized settings and displayed on menus and toolbars. Your toolbar might be displayed on two rows instead of one. To make the toolbar appear on one line, as shown in this text, click the left side of the second toolbar row and drag it to the first toolbar row. You can also select Customize from the Tools menu, then Toolbars, and select the option for the Standard and Formatting toolbars to be shown on two rows.

To access and explore different views:

1. **Explore the Network Diagram view**: Click the **Network Diagram** button on the View bar, and then click the **Zoom Out** button on the toolbar twice. Your screen should resemble Figure A-13.

![Network Diagram View of Software Development File](image-url)
2. **Explore the Calendar view.** Click the **Calendar** button on the View bar. Your screen should resemble Figure A-14.

![Figure A-14. Calendar View of Software Development File](image)

3. **Examine columns in the Entry table.** Click the **Gantt Chart** button on the View bar, and then move the **split bar** by moving your mouse between the Entry table and Gantt chart until you see the resize pointer. Click and drag your mouse to the right almost to the end of the screen to reveal other columns in the Entry table.

4. **Examine the Table: Schedule view.** Click **View** on the menu bar, move your mouse to **Table: Entry**, and then click **Schedule** in the cascading menu to the right. Notice that the columns to the left of the Gantt chart now display more detailed schedule information.

5. **Right-click the Select All button to access different table views.** Move your mouse to the **Select All** button to the left of the Indicator column symbol, and then **right-click** with your mouse. A shortcut menu to different table views displays, as shown in Figure A-15. Experiment with other table views, then return to the Table: Entry view.
6. Explore the Reports feature. Click **View** on the menu bar, click **Reports**, and then double-click **Overview** from the Reports dialog box. Double-click **Project Summary** in the Overview Reports dialog box. Notice that the insertion point now resembles a magnifying glass. Click inside the report to Zoom In or Zoom Out. Click the **Close** button to close this report, and then experiment with viewing other reports. You will use several reports and other views throughout this appendix.

7. Close the Reports feature. Click **Close** to close the Reports dialog box and return to the Gantt Chart view.

**Project 2002 Filters**

Project 2002 uses an underlying relational database to filter, sort, store, and display information. This database is compatible with Microsoft Access, and it is...
relatively easy to import information from and export information to other applications. Project 2002 is an Object Linking and Embedding for Databases (OLE-DB) provider, meaning that it has low-level connectivity between multiple types of data sources. For example, you can import or export data to other applications such as Excel, Access, Oracle, and so on.

You can filter information by clicking the Filter text box list arrow on the toolbar. Figure A-16 shows the resulting list of filters. You can access more filter options by using the scroll bar.

Filtering project information is very useful. For example, if a project includes hundreds of tasks, you might want to view only summary or milestone tasks to get an overview of the project. To get this type of overview of a project, select the Milestones or Summary Tasks filter from the Filter list. If you are concerned about the schedule, you can select a filter that shows only tasks on the critical path. Other filters include Completed Tasks, Late/Overbudget Tasks, and Date Range, which displays tasks based on dates you provide. As shown earlier, you can also click the Show list arrow on the toolbar to quickly display different levels in the WBS. For example, Outline Level 1 shows the highest-level items in the WBS, Outline Level 2 shows the next level of detail in the WBS, and so on.
To explore Project 2002 filters:

1. **Filter to show specific tasks.** From the Table: Entry view in the Software Development file, apply a filter to see only summary tasks. Click the Filter list arrow, scroll down until you see Summary Tasks, and then click Summary Tasks. Click Zoom Out on the toolbar once, or as needed, so the timescale displays quarters. Your screen should resemble Figure A-17.

   ![Figure A-17. Summary Tasks Filter for Software Development File](image)

   If the Filter text box does not appear on your toolbar, click Toolbar options and add the Filter button to the Formatting toolbar.

2. **Show outline levels.** Select All Tasks from the Filter list box to reveal all the tasks in the WBS again. Click the Show list arrow, and then click Outline Level 2. Now the level 2 items and above appear in the WBS. This file only goes down to WBS level 2. Experiment with other outline levels and filters.

3. **Examine other template files.** When you are finished reviewing the Software Development file, click Close from the File menu or click the Close button. A Save Changes dialog box appears. Click No. Open and examine other template files as you desire.

4. **Exit Project 2002.** Select Exit from the File menu or click the Close button for Project 2002.
Now that you are familiar with Project 2002 main screen elements, views, and filters, you will learn how to use Project 2002 to assist in project scope management by creating a new project file, developing a WBS, and setting a baseline.

PROJECT SCOPE MANAGEMENT

Project scope management involves defining the work to be done to carry out the project. To use Project 2002, you must first determine the scope of the project. To begin determining the project’s scope, create a new file with the project name and start date. Develop a list of tasks that need to be done to carry out the project. This list of tasks becomes the work breakdown structure (WBS; see Chapter 5). If you intend to track actual project information against the initial plan, you must set a baseline. In this section, you will learn how to create a new project file, develop a WBS, and set a baseline. Assume you are just like Terry Dunlay from the opening case, and you are learning how to use Project 2002 to help plan and manage the Project Tracking Database project. To start, you will enter the scope-related information.

In this section, you will go through several steps to create a Project 2002 file named scope.mpp. If you want to download the completed file to check your work or continue to the next section, a copy of scope.mpp is available on the companion Web site for this text or from your instructor. You should try to complete an entire section of this appendix (project scope management, project time management, and so on) in one sitting to create the complete file.

Creating a New Project File

To create a new project file:

1. Create a blank project. Open Project 2002, and close the New Project Task pane and the Project Guide window. Project 2002 automatically opens a blank project file when you start the application. If Project 2002 is already open and you want to open a new file, click the New icon on the toolbar, similarly to other Office applications.
2. **Open the Project Information dialog box.** Click **Project** on the menu bar, and then click **Project Information** to display the Project Information dialog box, as shown in Figure A-18. The Project Information dialog box enables you to set dates for the project, select the calendar to use, and view project statistics. The project start date will default to today’s date. The default filenames are Project1, Project2, and so on.

3. **Enter the project start date.** In the Start date text box, enter 4/04/05. Setting your project start date to 4/04/05 will ensure that your work matches the results that appear in this appendix. Leave the Finish date, Current date, and other information at the default settings. Click **OK**.

4. **Enter project properties.** Click **File** on the menu bar, and then click **Properties**. You may need to click the arrows to expand the menu to show Properties.

   Any command that you click in the expanded menu is added immediately to the personalized (short) version of the menu. If you stop using a command for a while, Project 2002 stops showing it on the short version of the menu.

5. **Enter project information.** Type **Project Tracking Database** in the Title text box, type **Terry Dunlay** in the Author text box, as shown in Figure A-19, and then click **OK**.

![Figure A-18. Project Information Dialog Box](image)
You may have some default information entered in the Project Properties dialog box, such as your company’s name. Also, as with other Office applications, you can change the default toolbar and menu options. Select Tools, Customize, and then Toolbars from the menu bar. On the Options tab, you can personalize menus and toolbars. To display the Project 2002 toolbars on one row, uncheck the first check box for Standard and Formatting toolbars to be on two rows. To always display the full set of menu options, make sure the check box for the second item—Menus show recently used commands first—is unchecked.

Developing a Work Breakdown Structure

Before using Project 2002, you must develop a work breakdown structure (WBS) for your project. Developing a good WBS takes time, and it will make entering tasks into the Entry table easier if you develop the WBS first. It is also a good idea to establish milestones before entering tasks in Project 2002. See
Chapter 5, Project Scope Management, for more information on creating a WBS and determining milestones. You will use the information in Table A-2 to enter tasks for the Project Tracking Database project. Be aware that this example is much shorter and simpler than most WBSs.

To develop a work breakdown structure and enter milestones for the Project Tracking Database project:

1. **Enter task names.** Enter the twenty tasks in Table A-2 into the Task Name column in the order shown. Do not worry about durations or any other information at this time. Type the name of each task into the Task Name column of the Entry table, beginning with the first row. Press Enter or the down arrow key on your keyboard to move to the next row. If you accidentally skip a task, highlight the task row and select Insert from the menu bar, then select New Task, to insert a blank row. To edit a task entry, click the text for that task, click the entry bar under the formatting toolbar, and either type over the old text or edit the existing text.

2. **Move the split bar to reveal more columns.** If necessary, move the split bar to the right to reveal the entire Task Name and Duration columns.

Table A-2: Project Tracking Database Tasks

<table>
<thead>
<tr>
<th>ORDER</th>
<th>TASKS</th>
<th>ORDER</th>
<th>TASKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Initiating</td>
<td>11</td>
<td>Design</td>
</tr>
<tr>
<td>2</td>
<td>Kickoff meeting</td>
<td>12</td>
<td>Implementation</td>
</tr>
<tr>
<td>3</td>
<td>Develop project charter</td>
<td>13</td>
<td>System implemented</td>
</tr>
<tr>
<td>4</td>
<td>Charter signed</td>
<td>14</td>
<td>Controlling</td>
</tr>
<tr>
<td>5</td>
<td>Planning</td>
<td>15</td>
<td>Report performance</td>
</tr>
<tr>
<td>6</td>
<td>Develop project plans</td>
<td>16</td>
<td>Control changes</td>
</tr>
<tr>
<td>7</td>
<td>Review project plans</td>
<td>17</td>
<td>Closing</td>
</tr>
<tr>
<td>8</td>
<td>Project plans approved</td>
<td>18</td>
<td>Prepare final project report</td>
</tr>
<tr>
<td>9</td>
<td>Executing</td>
<td>19</td>
<td>Present final project</td>
</tr>
<tr>
<td>10</td>
<td>Analysis</td>
<td>20</td>
<td>Project completed</td>
</tr>
</tbody>
</table>

Entering tasks into Project 2002 and editing the information is similar to entering and editing data in an Excel spreadsheet. The 2002 version of Project 2002 has a new feature called a SmartTag, which appears when you delete a row to clarify whether you want to delete the entire task or only clear the contents of a cell.
3. Adjust the Task Name column width, as needed. To make all the text display in the Task Name column, move the mouse over the right-column gridline in the Task Name header until you see the resize pointer, then click the **left mouse** button and drag the line to the right to make the column wider or double-click to automatically adjust the column width.

Notice that this WBS separates tasks according to the project management process groups of initiating, planning, executing, controlling, and closing. These tasks will be the level 1 items in the WBS for this project. It is a good idea to include all of these process group tasks, rather than focus only on the executing tasks of a project, as many people do. Recall that the WBS should include all of the work required for the project. In the Project Tracking Database WBS, the tasks will purposefully be left at a high WBS level (level 2). You will create these levels, or the WBS hierarchy, next when you create summary tasks. For a real project, you would usually break the WBS into even more levels to provide more details to describe all the work involved in the project. For example, analysis tasks for a database project might be broken down further to include preparing entity relationship diagrams for the database and developing guidelines for the user interface. Design tasks might be broken down to include preparing prototypes, incorporating user feedback, entering data, and testing the database. Implementation tasks might include more levels, such as installing new hardware or software, training the users, fully documenting the system, and so on.

**Creating Summary Tasks**

After entering the WBS tasks listed in Table A-2 into the Entry table, the next step is to show the WBS levels by creating summary tasks. The summary tasks in this example are Tasks 1 (initiating), 5 (planning), 9 (executing), 14 (controlling), and 17 (closing). You create summary tasks by highlighting and indenting their respective subtasks.

To create the summary tasks:

1. **Select lower-level or subtasks.** Highlight **Tasks 2 through 4** by left-clicking the text for Task 2 and dragging the mouse through the text for Task 4.
2. **Indent subtasks.** Click the **Indent** icon on the Formatting toolbar, so your screen resembles Figure A-20. After the subtasks (Tasks 2 through 4) are indented, notice that Task 1 automatically becomes boldface, which indicates that it is a summary task. A minus sign appears to the left of the new summary task name. Clicking the minus sign will collapse the summary task and hide the subtasks beneath it. When subtasks
are hidden, a plus sign + appears to the left of the summary task name. Clicking the plus sign will expand the summary task. Also, notice that the symbol for the summary task on the Gantt chart has changed from a blue line to a black line with arrows indicating the start and end dates.

Figure A-20. Indenting Tasks to Create the WBS Hierarchy

3. Create other summary tasks and subtasks. Create subtasks and summary tasks for Tasks 5, 9, 14, and 17 by following the same steps. Indent Tasks 6 through 8 to make Task 5 a summary task. Indent Tasks 10 through 13 to make Task 9 a summary task. Indent Tasks 15 through 16 to make Task 14 a summary task. Indent Tasks 18 through 20 to make Task 17 a summary task.

To change a task from a subtask to a summary task or to change its level in the WBS, you can “outdent” the task. Highlight the task or tasks you wish to change, and click the Outdent icon on the Formatting toolbar. Remember that the tasks in Project 2002 should be entered in an appropriate WBS format with several levels in the hierarchy.
Numbering Tasks

Depending on how Project 2002 is set up on your computer, you may or may not see numbers associated with tasks as you enter and indent them.

To display automatic numbering of tasks, using the standard tabular numbering system for a WBS:

1. Display the Options dialog box. Click Tools on the menu bar, and then click Options. The Options dialog box opens.
2. Show outline numbers. In the Options dialog box, click the View tab, if necessary. In the Outline options section of the View options for Project 1 section (at the bottom of the dialog box), click Show Outline Number so that a check mark appears in the check box. Figure A-21 shows the Options dialog box and resulting outline numbers applied to the WBS tasks. Click OK to close the dialog box.

Figure A-21. Adding Outline Numbers

Saving Project Files With or Without a Baseline

An important part of project management is tracking performance against a baseline. Project 2002, unlike previous versions, does not prompt you to save a file with or without a baseline each time you save it. The default is to save without a baseline. It is important to wait until you are ready to save your file with a baseline, because Project 2002 will show changes against a baseline. Because you are still developing your project file for the Project Tracking Database project, you want to save the file without a baseline. Later in this
appendix, you will save the file with a baseline by selecting Tools, Tracking, and then Set Baseline. You will then enter actual information to compare planned and actual performance data.

To save a file without a baseline:

1. **Save your file.** Save your file by clicking **File** on the menu bar and then clicking **Save**, or by clicking the **Save** icon .

2. **Enter a filename.** In the Save As dialog box, type **scope** in the File name text box. Save the file in your personal folder, on a floppy disk, or in the C:\temp folder, depending on how your computer is set up. Click **Save**. Your Project 2002 file should look like Figure A-22. (You can adjust the timescale to show months by clicking Zoom In or Zoom Out.)

   If you wish to download the Project 2002 file to check your work or continue to the next section, a copy of scope.mpp is available on the companion Web site for this text or from your instructor.

![Project 2002 Scope File](http://office.microsoft.com/downloads/2002/prjcomvi.aspx)

tool makes it easy to create a WBS in chart form based on the hierarchy entered in Project 2002. Figure A-23 shows the WBS chart created with the Visio WBS Chart Wizard. Contact Microsoft Product Support for assistance with this tool.

![Figure A-23. Visio WBS Chart Wizard](image)

Now that you have finished entering all twenty tasks, created the summary tasks and subtasks, set the options to show the standard WBS tabular numbering system, and saved your file, you will learn how to use the Project 2002 time management features.

## PROJECT TIME MANAGEMENT

Many people use Project 2002 for its time management features. The first step in using these features, after entering the WBS for the project, is to enter durations for tasks or specific dates when tasks will occur. Entering durations or specific dates will automatically update the Gantt chart. If you plan to do critical path analysis, you must also enter task dependencies. After entering durations and task dependencies, you can view the network diagram and critical path information. This section describes how to use each of these time management features.
Entering Task Durations

When you enter a task, Project 2002 automatically assigns to it a default duration of one day, followed by a question mark. To change the default duration, type a task’s estimated duration in the Duration column. If you are unsure of an estimate and want to review it again later, enter a question mark after it. For example, you could enter 5d? for a task with an estimated duration of five days that you want to review later. You can then use the Tasks With Estimated Durations filter to quickly see the tasks for which you need to review duration estimates.

To indicate the length of a task’s duration, you must type both a number and an appropriate duration symbol. If you type only a number, Project 2002 automatically enters days as the duration unit. Duration unit symbols include:

- d = days (default)
- w = weeks
- m = minutes
- h = hours
- mon = months
- ed = elapsed days
- ew = elapsed weeks

For example, to enter one week for a task duration, type 1w in the Duration column. To enter two days for a task duration, type 2d in the Duration column. The default unit is days, so if you enter 2 for the duration, it will be entered as 2 days. You can also enter elapsed times in the Duration column. For example, 2ed means two elapsed days, and 2ew means two elapsed weeks. You would use an elapsed duration for a task like “Allow paint to dry.” The paint will dry in exactly the same amount of time regardless of whether it is a workday, a weekend, or a holiday.

If the Duration column is not visible, move the mouse over the split bar until the resize pointer is visible. Click and drag the split bar to the right until the Duration column is in view.

Entering time estimates or durations might seem like a straightforward process. However, you must follow a few important procedures:

- As you saw in the previous section, when you enter a task in the Task Name column, 1 day? appears in the Duration column. The question mark means that you are unsure of the duration or want to go back to it. Be sure to enter the durations you want to appear.
Do not enter durations for summary tasks. Summary task durations are calculated automatically, based on the subtasks. If you enter a duration for a task and then make it a summary task, its duration will automatically change to match the durations of its subtasks. Project 2002 will not allow you to enter or change the duration of a summary task. Think of it as entering durations for work packages, the lowest-level items in your WBS. The other items are really the WBS hierarchy. Let Project 2002 do the duration calculations for you.

To mark a task as a milestone, enter 0 for the duration. You can also make tasks that have a non-zero duration as milestones by checking the Mark as milestone option in the Task Information dialog box on the Advanced tab. The milestone symbol for them will appear at their start date. Double-click on a task to access the Task Information dialog box.

To enter recurring tasks, such as weekly meetings or monthly status reports, select Recurring Task from the Insert menu. Enter the task name, the duration, and when the task occurs. Project 2002 will automatically insert appropriate subtasks based on the length of the project and the number of tasks required for the recurring task. For example, if you enter a recurring task for monthly review meetings that occur on the first day of every month for a twelve-month project, Project 2002 will enter a summary task for monthly review meetings and twelve subtasks—one meeting for each month.

You can enter the exact start and finish dates for activities, instead of entering durations. To enter start and finish dates, move the split bar to the right to reveal the start and finish columns. Enter start and finish dates only when those dates are certain. If you want task dates to adjust according to any other task dates, do not enter exact start and finish dates. Instead, you should enter a duration and then establish a dependency to related tasks. The real scheduling power of Project 2002 comes from setting up dependencies or relationships among tasks, as described in the next section.

Project 2002 uses a default calendar with standard workdays and hours. Duration estimates will vary according to the calendar used. For example, entering 5d in the standard calendar may result in more than 5 days on the Gantt chart if the time period includes Saturday or Sunday. You can change specific working and nonworking days or the entire project calendar by selecting Change Working Time from the Tools menu.

You often need to adjust the timescale on the Gantt chart to see your project’s schedule in different time frames, such as weeks, months, quarters, or years. You expand the timescale by clicking the Zoom Out icon. The Zoom In icon collapses the timescale. You can also change the format of the timescale by having three tiers instead of two or by formatting dates differently by double-clicking on the timescale section of the Gantt chart.
Next, you will set task durations in your Project Tracking Database file, created in the previous section. If you did not create the file named scope.mpp, you can download it from the companion Web site for this text. You will create a new recurring task and enter its duration, and then you will enter other task durations. First, create a new recurring task called Status Reports above Task 15, Report Performance.

To create a new recurring task:

1. **Insert a recurring task above Task 15, Report performance.** Open scope.mpp, if necessary, and then click **Report performance** (Task 15) in the Task Name column to select that task. Click **Insert** on the menu bar, then click **Recurring Task**. The Recurring Task Information dialog box opens.

2. **Enter task and duration information for the recurring task.** Type **Status Reports** as the task title in the Task Name text box. Type **1h** in the Duration text box. Select **Weekly** from the Recurrence Pattern radio buttons. Select **Every** from the Week On drop-down list. On the list of days, check **Wednesday**. In the Range of Recurrence section, type **4/6/05** in the Start text box, click the **End by:** radio button to select it, and type **9/7/05** in the End By text box. Select the drop-down list in the End By text box to see the calendar, as shown in Figure A-24. You can use the calendar to enter the Start: and End by: dates. You can also enter a number of occurrences instead of a To date for a recurring task. You might need to adjust the End by date after you enter all of your task durations and dependencies. Your screen should resemble Figure A-24. The new recurring task will appear above Task 15, Report Performance, when you are finished.

![Figure A-24. Recurring Task Information Dialog Box](image-url)
3. **View the new summary task and its subtasks.** Click **OK**. Project 2002 inserts a new Status Reports subtask in the Task Name column. Note that this new subtask is boldface and has a plus sign [+] to the left of the task name. Expand the new subtask by clicking [+] to the left of the words Status Reports. To collapse the recurring task, click the minus sign [−].

4. **Adjust the Duration column width and Gantt chart timescale.** Notice the # signs that appear in the Duration column for the Status Reports task. Like Excel, Project 2002 uses these symbols to denote that the column width needs to be increased. Increase the Duration column’s width by moving your mouse to the right of the Duration column heading until you see a resize pointer [ ]. Double-click [ ] to adjust the column width automatically to display the information. Adjust the time scale of the Gantt chart to display quarters by clicking the Zoom Out [ ] icon on the toolbar three times. Your screen should resemble Figure A-25. Notice that the recurring task appears on the appropriate dates on the Gantt chart.

![Figure A-25. Expanding a Recurring Task](image)

Use the information in Table A-3 to enter durations for the other tasks for the Project Tracking Database project. The Project 2002 row number is shown to the left of each task name in the table. Remember that you already entered a duration for the recurring task. Also, remember that you should **not** enter durations for summary tasks. Durations for summary tasks are automatically calculated to match the durations and dependencies of subtasks, as described further in the next section, “Establishing Task Dependencies.”
To enter task durations for the other tasks:

1. Enter the duration for Task 2. Click the Duration column for row 2, Kickoff meeting, type 2h, and then press Enter.
2. Enter the duration for Task 3. In the Duration column for row 3, Develop project charter, type 10d, then press Enter.
3. Enter remaining task durations. Continue to enter the durations, using information in Table A-3.
4. Save your file and name it. Click File on the menu bar, and then click Save As. Enter time for the filename, and save the file in the desired location on your computer or network.

Table A-3: Durations for Project Tracking Database Tasks

<table>
<thead>
<tr>
<th>Task Number/Row</th>
<th>Task Name</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Kickoff meeting</td>
<td>2h</td>
</tr>
<tr>
<td>3</td>
<td>Develop project charter</td>
<td>10d</td>
</tr>
<tr>
<td>4</td>
<td>Charter signed</td>
<td>0d</td>
</tr>
<tr>
<td>6</td>
<td>Develop project plans</td>
<td>3w</td>
</tr>
<tr>
<td>7</td>
<td>Review project plans</td>
<td>4mon</td>
</tr>
<tr>
<td>8</td>
<td>Project plans approved</td>
<td>0d</td>
</tr>
<tr>
<td>10</td>
<td>Analysis</td>
<td>1mon</td>
</tr>
<tr>
<td>11</td>
<td>Design</td>
<td>2mon</td>
</tr>
<tr>
<td>12</td>
<td>Implementation</td>
<td>1mon</td>
</tr>
<tr>
<td>13</td>
<td>System implemented</td>
<td>0d</td>
</tr>
<tr>
<td>39</td>
<td>Report performance</td>
<td>5mon</td>
</tr>
<tr>
<td>40</td>
<td>Control changes</td>
<td>5mon</td>
</tr>
<tr>
<td>42</td>
<td>Prepare final project report</td>
<td>2w</td>
</tr>
<tr>
<td>43</td>
<td>Present final project</td>
<td>1w</td>
</tr>
<tr>
<td>44</td>
<td>Project completed</td>
<td>0d</td>
</tr>
</tbody>
</table>
Establishing Task Dependencies

To use Project 2002 to adjust schedules automatically and to do critical path analysis, you must determine the dependencies or relationships among tasks (see Chapter 6, Project Time Management). Project 2002 provides three methods for creating task dependencies: using the Link Tasks icon; using the Predecessors column of the Entry table; or clicking and dragging the Gantt chart symbols for tasks with dependencies.

To create dependencies using the Link tasks icon, highlight tasks that are related and click the Link Tasks icon on the toolbar. For example, to create a finish-to-start dependency between Task 1 and Task 2, click any cell in row 1, drag down to row 2, and then click the Link Tasks icon. The default type of link is finish-to-start. In the Project Tracking Database example, all the tasks use this default relationship. You will learn about other types of dependencies later in this appendix.

Selecting tasks is similar to selecting cells in Microsoft Excel. To select adjacent tasks, you can click and drag the mouse. You can also click the first task, hold down the Shift key, and then click the last task. To select nonadjacent tasks, hold down the Control (Ctrl) key as you click tasks in order of their dependencies.

When you use the Predecessors column of the Entry table to create dependencies, you must manually enter the information. To create dependencies manually, type the task row number of the preceding task in the Predecessors column of the Entry table. For example, Task 3 in Table A-3 has Task 2 as a predecessor, as entered in the Predecessors column, meaning that Task 3 cannot start until Task 2 is finished. To see the Predecessors column of the Entry table, move the split bar to the right.

You can also create task dependencies by clicking the Gantt chart symbol for a task and then dragging to the Gantt chart symbol for a task that succeeds it. For example, you could click the Milestone symbol for Task 4, hold down the left mouse button, and drag to the Task Bar symbol for Task 6 to create a dependency, as shown in the Gantt chart in Figure A-26. Note the Finish-to-Start Link dialog box that appears when you use this method.
Next, you will use information from Figure A-27 to enter the predecessors for tasks as indicated. You will create some dependencies by manually typing the predecessors in the Predecessors column, some by using the Link Tasks icon, some by using the Link Tasks icon, some by using the Gantt chart symbols, and the remaining dependencies by using whichever method you prefer.

To link tasks or establish dependencies for the Project Tracking Database project:

1. **Display the Predecessors column in the Entry table.** Move the Split bar to the right to reveal the Predecessors column in the time.mpp file. Widen the Task Name or other columns, if needed.

2. **Highlight the cell where you want to enter a predecessor, and then type the task number for the preceding task.** Click the Predecessors cell for Task 3, type 2, and press **Enter**.

3. **Enter predecessors for Task 4.** In the Predecessors cell for Task 4, type 3, and press **Enter**. Notice that as you enter task dependencies, the Gantt chart changes to reflect the new schedule.
4. Establish dependencies using the Link Tasks icon. To link Tasks 10 through 13, click the task name for Task 10 in the Task Name column and drag down through Task 13. Then, click the Link Tasks icon on the toolbar.

5. Create a dependency using Gantt chart symbols. Click the Milestone symbol for Task 4 on the Gantt chart, hold down the left mouse button, and drag to the Task Bar symbol for Task 6. (See Figure A-26 to see this step in progress.)

6. Enter remaining dependencies. Link the other tasks by manually entering the predecessors into the Predecessors column, or by using the Link Tasks icon, or clicking and dragging the Gantt chart symbols. You can view the dependencies in Figure A-27. For example, Task 8 has Task 6 as a predecessor, Task 10 has Task 8 as a predecessor, and so on. If you have entered all data correctly, the project should end on 9/19/05.

7. Adjust screen elements. Select View Bar from the View menu to collapse the View bar, and then drag the resize line between the Indicator column and the Task Name columns to the left to remove that column. When you finish, your screen should look like Figure A-27. Double-check your screen to make sure you entered the dependencies correctly.

Figure A-27. Project Tracking Database File with Durations and Dependencies Entered
8. Preview and save your file. Select Print Preview from the File menu or click the Print Preview icon on the toolbar. If your previewed file does not resemble Figure A-27, you may need to adjust the location of the split bar between the Entry table and the Gantt chart. The entire Predecessors column must be visible in the Gantt chart view for it to show up in the Print Preview. When you are finished, close the Print Preview and save your file again by clicking the Save icon. If you desire, print your file by clicking the Print icon or by selecting Print from the File menu.

If information in a column on the Entry table does not appear in the Print Preview, close the Print Preview and move the split bar to fully reveal the column, then select Print Preview again. Also, check your timescale to make sure you are not wasting paper by having too-detailed a timescale. You should not print your file until the Print Preview displays the desired information.

Changing Task Dependency Types and Adding Lead or Lag Time

A task dependency or relationship describes how a task is related to the start or finish of another task. Project 2002 allows for four task dependencies: finish-to-start (FS), start-to-start (SS), finish-to-finish (FF), and start-to-finish (SF). You can find detailed descriptions of these dependencies in Chapter 6 and in the Project 2002 Help facility under the keyword “dependency.” By using these dependencies effectively, you can modify the critical path and shorten your project schedule. (See Chapter 6 for a detailed discussion of critical path analysis.) The most common type of dependency is finish-to-start (FS). All of the dependencies in the Project Tracking Database example are FS dependencies. However, sometimes you need to establish other types of dependencies. This section describes how to change task dependency types. It also explains how to add lead or lag times between tasks. You will shorten the duration of the Project Tracking Database project by adding lead time between some tasks.

To change a dependency type, open the Task Information dialog box for that task by double-clicking the task name. On the Predecessors tab of the Task Information dialog box, select a new dependency type from the Type column list arrow.

The Predecessor tab also allows you to add lead or lag time to a dependency. You can enter both lead and lag time using the Lag column on the Predecessor tab. Lead time reflects an overlap between tasks that have a dependency. For example, if Task B can start when its predecessor, Task A, is half-finished, you can specify a finish-to-start dependency with a lead time of 50 percent for the successor task. Enter lead times as negative numbers. In this example, enter −50% in...
the first cell of the Lag column. Adding lead times is also called fast tracking and is one way to compress a project’s schedule (see Chapter 6).

Lag time is the opposite of lead time—it is a time gap between tasks that have a dependency. If you need a 2-day delay between the finish of Task C and the start of Task D, establish a finish-to-start dependency between Tasks C and D and specify a 2-day lag time. Enter lag time as a positive value. In this example, type 2d in the Lag column.

In the Project Tracking Database example, notice that work on design tasks does not begin until all the work on the analysis tasks has been completed (see Rows 10 and 11 on the WBS), and work on implementation tasks does not begin until all the work on the design tasks has been completed (see Rows 11 and 12 on the WBS). In reality, it is rare to wait until all of the analysis work is complete before starting any design work, or to wait until all of the design work is finished before starting any implementation work. It is also a good idea to add some additional time, or a buffer, before crucial milestones, such as a system being implemented. To create a more realistic schedule, add lead times to the design and implementation tasks and lag time before the system implemented milestone.

To add lead and lag times:

1. **Open the Task Information dialog box for Task 11, Design.** In the Task Name column, double-click the text for Task 11, Design. The Task Information dialog box opens. Click the Predecessors tab.

2. **Enter lead time for Task 11.** Type –10% in the Lag column, as shown in Figure A-28. Click OK. You could also type a value such as –5d to indicate a 5-day overlap. In the resulting Gantt chart, notice that the bar for this task has moved slightly to the left. Also, notice that the project completion date has moved from 9/19 to 9/15.

![Figure A-28. Adding Lead or Lag Time to Task Dependencies](https://example.com/figure-a-28.png)

4. Enter lag time for Task 13. Double-click the text for Task 13, *System Implemented*, type 5d in the Lag column for this task, and click OK. Move the split bar to the right, if necessary, to reveal the Predecessors column. When you are finished, your screen should resemble Figure A-29. Notice the slight overlap in the taskbars for Tasks 10 and 11 and the short gap between the taskbars for Tasks 12 and 13. You can zoom in to see the gap more clearly. The project completion date should be 9/19.

5. Save your file. Click File on the menu bar, and then Save. Or, click the Save icon on the toolbar.

You can enter or modify lead or lag times directly in the Predecessors column of the Entry table. Notice how the predecessors appear for Tasks 11, 12, and 13. For example, the Predecessor column for Task 11 shows 10FS-10%. This notation means that Task 11 has a finish-to-start (FS) dependency with Task 10 and a 10 percent lead. You can enter lead or lag times to task dependencies directly into the Predecessors column of the Entry table by using this same format: task row number, followed by type of dependency, followed by the amount of lead or lag.
Gantt Charts

Project 2002 shows a Gantt chart as the default view along with the Entry table. Gantt charts show the timescale for a project and all of its activities. In Project 2002, dependencies between tasks are shown on the Gantt chart by the arrows between tasks. Many Gantt charts, however, do not show any dependencies. Instead, as you might recall, network diagrams or PERT charts are used to show task dependencies. See Chapter 6 for more information about Gantt charts and network diagrams. This section explains important information about Gantt charts and describes how to make critical path information more visible in the Gantt Chart view.

You must follow a few important procedures when working with Gantt charts:

- To adjust the timescale, click the Zoom Out icon 📋 or the Zoom In icon 📌. Clicking these icons automatically makes the dates on the Gantt chart show more or less information. For example, if the timescale for the Gantt chart is showing months and you click the Zoom Out icon, the timescale will adjust to show quarters. Clicking Zoom Out again will display the timescale in years. Similarly, each time you click the Zoom In icon, the timescale changes to display more detailed time information—from years to quarters, quarters to months, and months to weeks.

- You can also adjust the timescale and access more formatting options by selecting Timescale from the Format menu. Adjusting the timescale enables you to see the entire Gantt chart on one screen and in the time increments that you desire.

- A Gantt Chart Wizard is available on the Format menu. This wizard helps you adjust the format of the Gantt chart. For example, you can select an option to display critical path information on the Gantt chart, and those items on the critical path will automatically display using a red bar.

- You can view a tracking Gantt chart by setting a baseline for your entire project or for selected tasks and then entering actual durations for tasks. The tracking Gantt chart view displays two taskbars, one above the other, for each task. One taskbar shows planned or baseline start and finish dates, and the other taskbar shows actual start and finish dates. You will find a sample tracking Gantt chart later in this appendix, after you enter actual information for the Project Tracking Database example.

Because you have already created task dependencies, you can now find the critical path for the Project Tracking Database project. You can view the critical tasks by changing the color of those items on the critical path in the Task Name column. You can also change the color of bars on the Gantt chart. Tasks on the critical path will automatically be red in the Network Diagram view, as described in the following section.
To make the text for the critical path tasks appear in red in the Entry table and on the Gantt chart:

1. Open the Text Styles dialog box. Open time.mpp, if necessary. Click Format on the menu bar, and then click Text Styles. The Text Styles dialog box opens.

2. Change the critical tasks color option to red. Click the list arrow next to the Item to Change option, and select Critical Tasks. In the color section, select Red, as shown in Figure A-30. Click OK to accept the changes to the text styles.

3. Open the Gantt Chart Wizard. Select Gantt Chart Wizard from the Format menu or click the Gantt Chart Wizard icon on the toolbar. The Gantt Chart Wizard opens. Click Next, and the next step of the Wizard appears.

4. Select the Critical Path option. Click the Critical path radio button, as shown in Figure A-31. Notice that the sample Gantt chart in the Gantt Chart Wizard displays some bars in red, representing tasks on the critical path. Click Finish to proceed to the next step in the Gantt Chart Wizard.
Figure A-31. Gantt Chart Wizard Showing Critical Path Format

5. **Format the Gantt chart.** Click **Format It**, and then click **Exit Wizard**. Critical task bars on the Gantt chart will now be red.

6. **Save your file without a baseline.** Click the **Save** icon on the toolbar to save your file.

Network Diagrams

The network diagrams in Project 2002 use the precedence diagramming method, with tasks displayed in rectangular boxes and relationships shown by lines connecting the boxes. In the Network Diagram view, tasks on the critical path are automatically shown in red.

To view the network diagram for the Project Tracking Database project:

1. **View the Network Diagram.** Click **View Bar** on the View menu, and then click the **Network Diagram** icon on the View Bar or select **Network Diagram** from the View menu.

2. **Adjust the Network Diagram view.** To see more tasks in the Network Diagram view, click the **Zoom Out** icon on the toolbar twice. You can also use the scroll bars to see different parts of the network diagram. Figure A-32 shows several of the tasks in the Project Tracking Database network diagram.
Database network diagram. Note that milestone tasks, such as Charter signed, appear as pointed rectangular boxes, while other tasks appear as rectangles. Tasks on the critical path automatically appear in red, while noncritical tasks appear in blue. Each task in the network diagram also shows information such as the start and finish dates, task ID, and duration. Move your mouse over any of the boxes to see them in a larger view. A dashed line on a network diagram represents a page break. You often need to change some of the default settings for the Network Diagram view before printing it.

Figure A-32. Network Diagram View

3. View the Help topic on rearranging network diagram boxes. Click the Microsoft Project Help icon on the toolbar or press F1 to display the Office Assistant. Type How do I rearrange the network diagram? in the text box and then click Search. Click the resulting Help topic called Rearrange Network Diagram boxes. Figure A-33 shows the resulting Project 2002 Help window. Note that you can change several layout options for the network diagram, hide fields, and manually position boxes. Close the Help window.
4. **Return to Gantt Chart view.** Return to the Gantt Chart view by clicking the Gantt Chart icon in the View bar or by selecting Gantt Chart from the View menu on the menu bar.

Some people create new Project 2002 files or add tasks to existing files in the Network Diagram view instead of the Gantt Chart view. To add a new task or node in the Network Diagram view, select New Task from the Insert menu, or press the Insert key on your keyboard. Double-click the new node to add a task name and other information. Create finish-to-start dependencies between tasks in Network Diagram view by clicking the preceding node and dragging to the succeeding node. To modify the type of dependency and add lead or lag time, double-click the arrow between the dependent nodes.
Critical Path Analysis

Recall that the critical path is the path through the network diagram with no slack or the least amount of slack; it represents the shortest possible time to complete the project (see Chapter 6). If a task on the critical path takes longer than planned, the project schedule will slip unless time is reduced on a task later on the critical path. Sometimes you can shift resources between tasks to help keep a project on schedule. Project 2002 has several views and reports to help analyze critical path information.

Two particularly useful features are the Schedule Table view and the Critical Tasks report. The Schedule Table view shows the early and late start dates for each task, the early and late finish dates for each task, and the free and total slack for each task. This information shows how flexible the schedule is and helps in making schedule compression decisions. The Critical Tasks report lists only tasks that are on the critical path for the project. If meeting schedule deadlines is essential for a project, project managers want to closely monitor tasks on the critical path.

To access the Schedule Table view and view the Critical Tasks report for a file:

1. **View the Schedule table.** Right-click the Select All button to the left of the Task Name column heading and select Schedule. Alternatively, you can click View on the menu bar, point to Table: Entry, and then click Schedule. The Schedule table replaces the Entry table to the left of the Gantt chart.

2. **Reveal all columns in the Schedule table.** Move the split bar to the right until you see the entire Schedule table. Your screen should resemble Figure A-34. This view shows the start and finish (meaning the early start and early finish) and late start and late finish dates for each task, as well as free and total slack. Right-click the Select all button and select Entry to return to the Entry table view.
3. Open the Reports dialog box. Click View on the menu bar, and then click Reports. Double-click Overview to open the Overview Reports dialog box. Your screen should resemble Figure A-35.

Figure A-35. Accessing the Critical Tasks Report

5. Close the report and save your file. When you are finished examining the Critical Tasks report, click Close. Click Close on the Reports dialog box. Click the Save icon on the toolbar to save your file.

If you want to download the completed time.mpp file to check your work or continue to the next section, a copy is available on the companion Web site for this text or from your instructor.

Now that you have entered task durations, established task dependencies, and reviewed the network diagram and critical path information, you are ready to explore some of the Project 2002 cost management features.

**PROJECT COST MANAGEMENT**

Many people do not use Project 2002 for cost management. Most organizations have more established cost management software products and procedures in place, and many people simply do not know how to use the cost features. Using the cost features of Project 2002, however, makes it possible to integrate total project information more easily. This section offers brief instructions for entering fixed and variable cost estimates and actual cost and time information after establishing a baseline plan. It also explains how to use Project 2002 for earned value management. More details on these features are available in Project 2002 Help, online tutorials, or other books.

To complete the hands-on steps in this section, you need to download the Project 2002 file resource.mpp from the companion Web site for this book and save it on a floppy disk or with your other project files on your hard drive.

**Fixed and Variable Cost Estimates**

The first step to using the cost features of Project 2002 is entering cost-related information. You enter costs as fixed or variable based on per-use material costs, or variable based on the type and amount of resources used. Costs related to personnel are often a significant part of project costs.
Entering Fixed Costs in the Cost Table

The Cost table allows you to enter fixed costs related to each task. To access the Cost table, right-click the Select All button and select Cost or select Table: Cost from the View menu. Figure A-36 shows the resulting view for the Project Tracking Database project using time.mpp. You can also assign a per-use cost to a resource that represents materials or supplies and use it as a base for calculating the total materials or supplies cost of a task. See Project 2002 Help for details on this feature.

![Figure A-36. Cost Table View](image)

Entering Human Resource Costs

Human resources represent a major part of the costs on many projects. By defining and then assigning human resources and their related costs to tasks in Project 2002, you can calculate human resource costs, track how people are used, identify potential resource shortages that could force you to miss deadlines, and identify underutilized resources. It is often possible to shorten a project’s schedule by reassigning underutilized resources. This section focuses on entering human resource costs and assigning resources to tasks. The following
section describes other features of Project 2002 related to human resource management.

There are several methods for entering resource information in Project 2002. One of the easiest is to enter basic resource information in the Resource Sheet. Access the Resource Sheet from the View bar, or by selecting Resource Sheet from the View menu. This Resource Sheet allows you to enter the resource name, initials, resource group, maximum units, standard rate, overtime rate, cost/use, accrual method, base calendar, and code. Entering data into the Resource Sheet is similar to entering data into an Excel spreadsheet, and you can easily sort items by selecting Sort from the Project menu. In addition, you can use the Filter list on the toolbar to filter resources. Once you have established resources in the Resource Sheet, you can assign those resources to tasks in the Entry table with the list arrow that appears when you click a cell in the Resource Names column. The Resource Names column is the last column of the Entry table. You can also use other methods for assigning resources, as described below.

Next, you will use the Project 2002 file time.mpp, which you saved in the preceding section, to assign resources to tasks. (If you did not save your file, download it from the companion Web site for this text.) Assume that there are four people working on the Project Tracking Database project, and assume that the only costs for this project are for these human resources: Kathy is the project manager; John is the business analyst; Mary is the database analyst; and Chris is an intern.

To enter basic information about each person into the Resource Sheet:

1. **Open the Resource Sheet view.** Open your Project 2002 file, time.mpp, if necessary. Click the **Resource Sheet** icon on the View bar (you may need to scroll to see it), or click **View** on the menu bar, and then click **Resource Sheet**.

2. **Enter resource information.** Enter the information from Table A-4 into the Resource Sheet. Type the information as shown and press the Tab key to move to the next field. Notice that you are putting abbreviated job titles in the Initials column: PM stands for project manager; BA stands for business analyst; DA stands for database analyst; and IN stands for intern. When you type the standard and overtime rates, you can just type 50, and Project 2002 will automatically enter $50.00/hr. The standard and overtime rates entered are based on hourly rates. You can also enter annual salaries by typing the annual salary number followed by /y for “per year.” Leave the default values for the other columns in the Resource Sheet as they are. Your screen should resemble Figure A-37 when you are finished entering the resource data.
If you know that some people will be available for a project only part-time, enter their percentage of availability in the Max Units column of the Resource Sheet. Project 2002 will then automatically assign those people based on their maximum units. For example, if someone can work only 25 percent of their time on a project throughout most of the project, enter 25% in the Max Units column for that person. When you enter that person as a resource for a task, his or her default number of hours will be 25 percent of a standard eight-hour workday, or two hours per day.

### Adjusting Resource Costs

To make a resource cost adjustment, such as a raise, for a particular resource, double-click the person’s name in the Resource Name column, select the Costs tab in the Resource Information dialog box, and then enter the effective date and raise percentage. You can also adjust other resource cost information, such as standard and overtime rates.

To give the project manager a 10 percent raise starting 6/1/05:

2. Enter an effective date for a raise. Select the Costs tab, and then select tab A, if needed. Type 6/1/05 in the second cell in the Effective Date column and press Enter. Alternately, click the list arrow in the second cell and use the calendar that appears to enter the effective date.

3. Enter the raise percentage. Type 10% in the second cell for the Standard Rate column, and then press Enter. The Resource Information screen should resemble the screen shown in Figure A-38. Notice that Project 2002 calculated the 10% raise to be $55.00/h. Click OK.

![Figure A-38: Adjusting Resource Costs](image)

Assigning Resources to Tasks

For Project 2002 to calculate resource costs, you must assign the appropriate resources to tasks in your WBS. There are several methods for assigning resources. The Resources column in the Entry table allows you to select a resource using a drop-down list. You can, however, use this method to assign only one resource to a task full-time. You often need to use other methods to assign resources, such as the Assign Resources icon on the toolbar or the Resource Cost window, to ensure that Project 2002 captures resource assignments as you intend them. Next, you will use these three methods for assigning resources to the Project Tracking Database project.
Assigning Resources Using the Entry Table

To assign resources using the Entry table:

1. Select the task to which you want to assign resources. Click the Gantt Chart icon on the View bar, or click View Table: Entry, if necessary, to return to that view. Make sure that Task 2, Kickoff meeting, is selected.

2. Reveal the Resource Names column of the Entry table. Move the split bar to the right to reveal the entire Resource Names column in the Entry table.

3. Select a resource from the Resource Names column. Click the drop-down arrow in the Resource Names column, and then click Kathy to assign her to Task 2. Notice that the resource choices are based on information that was entered in the Resource Sheet. If you had not entered any resources, you would not have a drop-down arrow or any choices to select.

4. Try to select another resource for Task 2. Again, click the drop-down arrow in the Resource Names column for Task 2, click John, and then press Enter. Notice that only John’s name appears in the Resource Names column. You can assign only one resource to a task using this method.

5. Clear the resource assignment. Right-click the Resource Names column for Task 2, and then select Clear Contents to remove the resource assignments.

Assigning Resources Using the Toolbar

To assign resources using the toolbar:

1. Select the task to which you want to assign resources. Click the task name for Task 2, Kickoff meeting, in the second row of the Task Name column.

2. Open the Assign Resource dialog box. Click the Assign Resources icon on the toolbar. The Assign Resources dialog box, which lists the names of the people assigned to the project, is displayed, as shown in Figure A-39. This dialog box remains open while you move from task to task to assign resources. If your Resource list options button is not expanded, you can click the + sign to expand it. You click the – sign to collapse it.
3. **Assign Kathy to Task 2.** Click **Kathy** in the Resource Name column of the Assign Resources dialog box, and then click **Assign.** Notice that the duration estimate for Task 2 remains at 2 hours, and Kathy’s name appears on the Gantt chart by the bar for Task 2.

4. **Assign John to Task 2.** Click **John** in the Resource Name column of the Assign Resources dialog box, and then click **Assign.** The duration for Task 2 changes to 1 hour, **but you do not want this change to occur.** Click **Close** in the Assign Resources dialog box.

5. **Clear resource assignments.** Right-click the **Resource Names** column for Task 2, and then select **Clear Contents** to remove the resource assignments.

6. **Reenter the duration for Task 2.** Type **2h** in the duration column for Task 2 and press **Enter.**

### Assigning Resources Using the Split Window and Resource Cost View

Even though using the Assign Resources icon seems simpler, it is often better to use a split window and the Resource Cost view when assigning resources. When you assign resources using the split view, the durations of tasks will not automatically change when you assign more resources, and you have more control over how you enter information. Project 2002 Help offers more information on different options for resource assignment.
To assign both Kathy and John to attend the two-hour kickoff meeting:

1. *Split the window to reveal more information.* Select **Window**, and then **Split** from the menu bar. The Gantt Chart view is displayed at the top of the screen and a resource information table is displayed at the bottom of the screen.

2. **Open the Resource Cost window.** Right-click anywhere in the bottom window and select **Resource Cost**.

3. **Assign Kathy to Task 2.** Select **Task 2** and click under **Resource Name** in the Resource Cost window. Click the **down arrow** and select **Kathy**.

4. **Assign John to Task 2.** Click in the cell below Kathy, and select **John**.

5. **Enter the resource assignment and review the Gantt chart.** Click **OK** in the lower window. Your screen should resemble Figure A-40. Notice that the duration for Task 2 is still 2 hours, and both Kathy and John are assigned to that task 100%. You can also enter a different percentage under the Units column if resources will not work 100% of their available time on a task. Note that the default settings are that tasks are Effort driven and the Task type is Fixed Units. You will learn more about these settings later.

![Figure A-40. Split Screen View for Entering Resource Information](image-url)
6. Open the Resource Schedule window. Right-click anywhere in the lower window and select Resource Schedule. Notice that Kathy and John are assigned to Task 2 for 2 hours, as you intended. You can also enter resource information using the Resource Schedule option.

7. Close the file and do not save it. Close the file, but do not save the changes you made. Other resource information has been entered for you in the Project 2002 file named resource.mpp, available on the companion Web site for this text.

As you can see, you must be careful when assigning resources. Project 2002 assumes that the durations of tasks are not fixed, but are effort-driven, and this assumption can create some problems when you are assigning resources. Figure A-41 shows the results of adding resources with different settings. The first four task entries assume the task, Design, is effort-driven. When you assign one resource to the design task, John, the duration is one month. If you later assign two resources, John and Mary, to that same task without changing any settings, Project 2002 automatically adjusts the duration of that task to half its original duration, or 0.05 months. If you change the task type to be Fixed Duration and assign two resources, the duration remains at one month and each resource is assigned 50 percent to the task. If you change the type to Fixed Work and assign two resources, the duration is cut in half and the resources are assigned full-time. The bottom part of Figure A-41 shows the results when a task is not effort-driven or when you assign the Fixed Work task type. You must be very careful when entering resource information to make sure the task duration and work hours reflect what you want.
Viewing Project Cost Information

Once you enter resource information, Project 2002 automatically calculates resource costs for the project. There are several ways to view project cost information. You can view the Cost table to see cost information, or you can run various cost reports. Next, you will view cost information for the Project Tracking Database project.

To view cost information:

1. **Open resource.mpp.** Download resource.mpp from the companion Web site for this text or get it from your instructor. Open the file.
2. **Open the Cost table.** Right click the Select All button and click Cost, or click View on the menu bar, point to Table: Entry, and then click Cost. The Cost table displays cost information and the Gantt chart. Move the split bar to the right to reveal all of the columns. Your screen should resemble Figure A-42. Note that by assigning resources, costs have been automatically calculated for tasks. You could also enter fixed costs for tasks in the cost table, but there are no fixed costs associated with this project.

![Figure A-41. Results of Adding Resources with Various Task Types](image)
3. **Open the Cost Reports dialog box.** Click **View** on the menu bar, and then click **Reports**. Double-click **Costs** to display the Cost Reports dialog box.

4. **Set the time units for the report.** Click **Cash Flow**, if necessary, and then click **Edit**. The Crosstab Report dialog box is displayed. Click the Column **drop-down arrow** and select **Months** instead of weeks in the Crosstab Report dialog box, if needed, as shown in Figure A-43. Click **OK**.

![Figure A-42. Cost Table for the Resource File](image1)

**Figure A-42. Cost Table for the Resource File**

![Figure A-43. Crosstab Report Dialog Box](image2)

**Figure A-43. Crosstab Report Dialog Box**
5. **View the Cash Flow report.** Click **Select** in the Cost Reports dialog box. A Cash Flow report for the Project Tracking Database appears, as shown in Figure A-44. Click **Close**.

![Microsoft Project - resource.mpp](image)

**Figure A-44. Cash Flow Report**

6. **View the Project Summary report.** In the Reports dialog box, double-click **Overview**, and then double-click **Project Summary**. A Project Summary report for the Project Tracking Database is displayed, listing information such as project baseline start and finish dates; actual start and finish dates; summaries of duration, work hours, and costs; as well as variance information. Since you have not yet saved the file as a baseline, much of this information is blank in the report. The Project Summary report provides a high-level overview of a project. Click **Close** to close the report after reviewing it. Click **Close** on the Reports dialog box.

You can edit many of the report formats in Project 2002. Instead of double-clicking the report, highlight the desired report, and then click **Edit**.

The total estimated cost for this project, based on the information entered, should be $49,314.25, as shown in the Cash Flow and Project Summary reports. In the next section, you will save this data as a baseline plan and enter actual information.
Baseline Plan, Actual Costs, and Actual Times

Once you complete the initial process of creating a plan—entering tasks, establishing dependencies, assigning costs, and so on—you are ready to set a baseline plan. By comparing the information in your baseline plan to an updated plan during the course of the project, you can identify and solve problems. After the project ends, you can use the baseline and actual information to plan similar, future projects more accurately. To use Project 2002 to help control projects, you must establish a baseline plan, enter actual costs, and enter actual durations.

Establishing a Baseline Plan

An important part of project management is setting a baseline plan. If you plan to compare actual information such as durations and costs, you must first save the Project 2002 file as a baseline. The procedure involves selecting Tracking, and then Save Baseline from the Tools menu. Before setting a baseline, you must complete the baseline plan by entering time, cost, and human resources information. Be careful not to save a baseline until you have completed the baseline plan. If you do save a baseline before completing the baseline plan, Project 2002 allows you to save up to ten baselines. You can then clear unwanted baseline plans.

Even though you can clear a baseline plan or save multiple baselines, it is a good idea to save a separate, backup file of the original baseline for your project. Enter actuals and save that information in the main file, but always keep a backup baseline file without actuals. Keeping separate baseline and actual files will allow you to return to the original file in case you ever need to use it again.

To rename resource.mpp and then save it as a baseline plan in Project 2002:

1. **Save resource.mpp as a new file named baseline.mpp.** Open resource.mpp, if necessary, click **File** on the menu bar, and then click **Save As**. Type **baseline** as the filename, and then click **Save**.
2. **Open the Save Baseline dialog box.** Click **Tools** on the menu bar, select **Tracking**, and then click **Save Baseline**. The Save Baseline dialog box is displayed (Figure A-45.)
3. Review the Save Baseline options, and save the entire project as a baseline. If necessary, click the **Save baseline** radio button and the **Entire project** radio button. Use the default option of the first Save baseline name of just Baseline. These options should be the default settings in Project 2002. Click **OK**.

Notice that there are several options in the Save Baseline dialog box, as shown in Figure A-45. You can save the file as an interim plan if you anticipate several versions of the plan. You can also select the entire project or selected tasks when saving a baseline or interim plan. You can also save up to ten baselines with Project 2002.

**Entering Actual Costs and Times**

After you set the baseline plan, it is possible to track information on each of the tasks as the project progresses. You can also adjust planned task information for tasks still in the future. The Tracking Table displays tracking information, and the Tracking Toolbar helps you enter this information. Figure A-46 describes each button on the Tracking Toolbar. The 100% icon and the Update as Schedule icon are the most commonly used icons for entering actual information.
To practice entering actual information, enter just a few changes to the baseline. Assume that Tasks 1 through 7 were completed as planned, but that Task 10 took longer than planned.

To enter actual information for tasks that were completed as planned:

1. **Display the Tracking toolbar.** Click **View** on the menu bar, select **Toolbars**, and then click **Tracking** from the **Toolbars** submenu to display the Tracking toolbar. Move the toolbar as desired.

---

### Table: Buttons on the Tracking Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![button]</td>
<td>Project Statistics</td>
<td>Provides summary information about the project baseline, the actual project start and finish dates, and overall project duration, costs, and work</td>
</tr>
<tr>
<td>![button]</td>
<td>Update as Scheduled</td>
<td>Updates the selected tasks to indicate that actual dates, costs, and work match the scheduled dates, costs, and work</td>
</tr>
<tr>
<td>![button]</td>
<td>Reschedule Work</td>
<td>Schedules the remaining duration for a task that is behind schedule so that it will continue from the status date</td>
</tr>
<tr>
<td>![button]</td>
<td>Add Progress Line</td>
<td>Displays a progress line on the Gantt chart from a date that you select on the timescale</td>
</tr>
<tr>
<td>![button]</td>
<td>0% Complete</td>
<td>Marks the selected tasks as 0% complete as of the status date (Actual date, work, and duration data is updated)</td>
</tr>
<tr>
<td>![button]</td>
<td>25% Complete</td>
<td>Marks the selected tasks as 25% complete as of the status date (Actual date, work, and duration data is updated)</td>
</tr>
<tr>
<td>![button]</td>
<td>50% Complete</td>
<td>Marks the selected tasks as 50% complete as of the status date (Actual date, work, and duration data is updated)</td>
</tr>
<tr>
<td>![button]</td>
<td>75% Complete</td>
<td>Marks the selected tasks as 75% complete as of the status date (Actual date, work, and duration data is updated)</td>
</tr>
<tr>
<td>![button]</td>
<td>100% Complete</td>
<td>Marks the selected tasks as 100% complete as of the status date (Actual date, work, and duration data is updated)</td>
</tr>
<tr>
<td>![button]</td>
<td>Update Tasks</td>
<td>Displays the Update Tasks dialog box for the selected tasks so that you can enter their percentages completed, actual durations, remaining durations, or actual start or finish dates</td>
</tr>
<tr>
<td>![button]</td>
<td>Collaborate Toolbar</td>
<td>Toggles on and off the Collaborate Toolbar, which displays buttons that enable you to share parts of the project with others</td>
</tr>
</tbody>
</table>

---


**Figure A-46. Buttons on the Tracking Toolbar**
2. Display the Tracking table. Right-click the Select All button, and then click Tracking to see more information as you enter actual data. Move the split bar to reveal all the columns in the Tracking table.

3. Mark Tasks 1 through 8 as 100% complete. Click the Task Name for Task 1, Initiating, and drag down through Task 8 to highlight the first eight tasks. Click the 100 percent icon on the Tracking toolbar. The columns with dates, durations, and cost information should now contain data instead of the default values, such as NA or 0. The % Comp column should display 100%. Adjust column widths if needed. Your screen should resemble Figure A-47.

![Figure A-47. Tracking Table Information](image)

4. Enter actual completion dates for Task 10. Click the Task Name for Task 10, Analysis, and then click the Update Tasks icon on the Tracking toolbar. The Update Tasks dialog box opens. For Task 10, enter the Actual Start date as 5/11/05 and the Actual Finish date as 6/16/05 in the Update Tasks dialog box, as shown in Figure A-48. Click OK.
5. **Display the Indicators column.** Click **Insert** on the menu bar and click **Column**, click the **Field name** list arrow, select **Indicators**, and then click **OK**. The Indicators column is displayed, showing a check mark by completed tasks.

6. **Review changes in the Gantt chart.** Move the split bar to the left to reveal more of the Gantt chart. Notice that the Gantt chart bars for completed tasks have changed. Gantt chart bars for completed tasks appear with a black line drawn through the middle.

   You can hide the Indicators column by dragging the right border of the column heading to the left.

You can also view actual and baseline schedule information more clearly with the Tracking Gantt Chart view. See Chapter 6 for descriptions of the symbols on a Tracking Gantt chart.

To display the Tracking Gantt chart:

1. **View the Tracking Gantt chart.** Click **View** on the menu bar, and then click **Tracking Gantt**. Alternatively, click the **Tracking Gantt** icon on the View bar. Adjust the horizontal scroll bar at the lower-right corner of the Gantt chart window, if necessary, to see symbols on the Gantt chart.

2. **Display Gantt chart information in months.** Click **Zoom Out** to display information in months. Your screen should resemble Figure A-49. (The Tracking Toolbar was turned off in this figure to display the entire schedule).
Figure A-49. Tracking Gantt Chart View

3. Save your file as a new file named tracking.mpp. Click File on the menu bar, then click Save As. Name the file tracking, and then click Save.

Notice the additional information available on the Tracking Gantt chart. Completed tasks have 100% by their symbols on the Tracking Gantt chart. Tasks that have not started yet display 0%. Tasks in progress, such as Task 9, show the percentage of the work completed (31% in this example). Also, note that the project completion date has moved to 9/29 since several tasks depended on completion of Task 10, which took longer than planned. Viewing the Tracking Gantt chart allows you to easily see your schedule progress against the baseline plan.

After you have entered some actuals, you can review earned value information for the initiating tasks of this project.

Earned Value Management

Earned value management (see Chapter 7, Project Cost Management) is an important project management technique for measuring project performance. Because you have entered actual information for the initiating tasks in the Project Tracking Database project, you can now view earned value information in Project 2002.
To view earned value information:

1. **View the Earned Value table.** Open **tracking.mpp**, if necessary, and then click **View** on the menu bar. Point to **Table: Entry**. Select **More Tables** to open the More Tables dialog box, and then double-click **Earned Value**.

2. **Display all the Earned Value table columns.** Move the split bar to the right to reveal all of the columns. Note that the Earned Value table includes columns for each earned value term described in Chapter 7. Also note that the EAC (Estimate at Completion) is higher than the BAC (Budget at Completion) starting with Task 9, where the task took longer than planned to complete (Figure A-50). The term VAC stands for Variance at Completion. Task 9 shows a VAC of ($2,779.00), meaning the project is projected to cost $2,779 more than planned at completion at that point in time. Remember that not all of the actual information has been entered yet.

![Figure A-50. Earned Value Table](image-url)

3. Close and save the file. Click the Save icon and then close the tracking.mpp file.

If you wish to check your work or continue to the next section, copies of the files baseline.mpp and tracking.mpp are available on the companion Web site for this text or from your instructor.

Further information on earned value is available from Project 2002 Help or in Chapter 7, Project Cost Management. To create an earned value chart, you must export data from Project 2002 into Excel. There are also add-in products you can use with Project 2002 to do more with earned value information. Consult Project 2002 Help and Microsoft’s Web site for Project 2002 (www.microsoft.com/project) for more details.

Now that you have entered and analyzed various project cost information, you will examine some of the human resource management features of Project 2002.

PROJECT HUMAN RESOURCE MANAGEMENT

In the project cost management section, you learned how to enter resource information into Project 2002 and how to assign resources to tasks. Two other helpful human resource features include resource calendars and histograms. In addition, it is important to know how to use Project 2002 to assist in resource leveling.

Resource Calendars

When you created the Project Tracking Database file, you used the standard Project 2002 calendar. This calendar assumes that standard working hours are Monday through Friday, from 8:00 a.m. to 5:00 p.m., with an hour for lunch starting at noon. Rather than using this standard calendar, you can create a different calendar that takes into account each project’s unique requirements.
To create a new base calendar:

1. *Open a new file.* Click the New icon on the Toolbar to open a new Project 2002 file.

2. *Open the Change Working Time dialog box.* Click **Tools** on the menu bar, and then click **Change Working Time.** The Change Working Time dialog box appears.

3. *Name the new base calendar.* In the Change Working Time dialog box, click **New.** The Create New Base Calendar dialog box appears. Click the **Create new base calendar** radio button, type **Mine** to name the new calendar in the **Name** text box, and then click **OK.** Make adjustments to create your own base calendar. Click **OK.**

You can use this new calendar for the whole project, or you can assign it to specific resources on the project.

To assign the new calendar to the whole project:

1. *Open the Project Information dialog box.* Click **Project** on the menu bar, and then click **Project Information.** The Project Information dialog box appears.

2. *Select a new calendar.* Click the **Calendar list arrow** to display a list of available calendars. Select your new calendar named **Mine** from this list, and then click **OK.**

To assign a specific calendar to a specific resource:

1. *Assign a new calendar.* Click **View** on the menu bar, and then click **Resource Sheet.** Type **Me** in the Resource Name column, press **Enter,** and then select the word **Me.**

2. *Select the calendar.* Click the **Base Calendar** cell for that resource name. Using the left mouse button, click the **list arrow** that appears, drag to select the **Mine** calendar, and release the mouse button.

3. *Block off vacation time.* Double-click a resource name to display the Resource Information dialog box, and then click the **Working Time** tab. You can block off vacation time for people by selecting the appropriate days on the calendar and marking them as nonworking days, as shown in Figure A-51.

4. *Close the file without saving it.* Click **File** on the menu bar, and then click **Close.** Click **No** when you are prompted to save the file.
Resource Histograms

A resource histogram is a type of chart that shows the number of resources assigned to a project over time (see Chapter 9, Project Human Resource Management). A histogram by individual shows whether a person is over- or underallocated during certain periods. To view histograms in Project 2002, select Resource Graph from the View bar or select Resource Graph from the View menu. The Resource Graph helps you see which resources are overallocated, by how much, and when. It also shows you the percentage of capacity each resource is scheduled to work, so you can reallocate resources, if necessary, to meet the needs of the project.

To view resource histograms for the Project Tracking Database project:

1. View the Resource Graph. Open the baseline.mpp file, and open the View Bar, if necessary. Click the Resource Graph icon on the View bar. If you cannot see the Resource Graph icon, you may need to click the up or down arrow on the View bar. Alternatively, you can click View on the menu bar, and then click Resource Graph. A histogram for Kathy appears, as shown in Figure A-52. Notice that the screen is divided into two sections. The left pane displays a person’s name and the right pane displays a resource histogram for that person. Also, notice that Kathy is overallocated slightly in the month of April since the column for that month goes above the 100% line.
2. **Adjust the histogram’s timescale.** Click **Zoom Out** or **Zoom In**, if necessary, to adjust the timescale for the histogram so that it appears in quarters and then months.

3. **View the next resource’s histogram.** Click the **right scroll arrow** at the bottom of the resource name pane. The resource histogram for the next person appears. View the resource histograms for all four people, and then go back to the first one for Kathy.

Notice that Kathy’s histogram has a partially red bar in April 2005. This red portion of the bar means that she has been overallocated during that month. The percentages at the bottom of each bar show the percentage each resource is assigned to work. For example, Kathy is scheduled to work 107% of her available time in April, 62% of her available time in May, and so on. Project 2002 has two tools that enable you to see more details about resource overallocation: the Resource Usage view and the Resource Management toolbar.
To see more details about an overallocated resource using the Resource Usage view:

1. **Open the Resource Usage view.** Click the Resource Usage icon from the View bar or click View on the menu bar, and then click Resource Usage.

2. **Adjust the information displayed.** On the right side of the screen, click the right scroll arrow to display the hours Kathy is assigned to work each day, starting in April. You may also need to click the scroll down arrow to see all of Kathy’s hours. If you need to adjust the timescale to display weeks, click Zoom Out or Zoom In. When you are finished, your screen should resemble Figure A-53.

3. **Examine overallocation information.** Notice that Kathy’s name appears in red, as does the value 5.57h in the column for Monday. Although Kathy is not scheduled to work more than 8 hours on Monday, some of the tasks were entered as hours, and Project 2002 assumes those hours start as soon as possible, thus causing the scheduling conflict. You’ll remove the conflict using the Hour by Hour leveling later in this section.

To learn more about an overallocated resource, you can also use the Resource Management toolbar for resource allocation.
To see more resource allocation information:

1. **View the Resource Management toolbar.** Click **View** on the menu bar, select **Toolbars**, and then click **Resource Management**. The Resource Management toolbar displays below the Formatting toolbar.

2. **Select the Resource Allocation view.** Click **Resource Allocation View** on the Resource Management toolbar. The Resource Allocation view appears, showing the Resource Usage view at the top of the screen and the Gantt Chart view at the bottom of the screen. Figure A-54 shows this view with Kathy’s information highlighted.

3. **Close the file, but do not save any changes.** Click **File** on the menu bar, and then click **Close**. Click **No** when you are prompted to save changes.

The Resource Allocation view can help you identify the source of a resource overallocation. It is fairly obvious that Kathy has a slight overallocation the first day of the project because she is assigned to three different tasks, for a total of 8.57 hours. You could fix this problem by reducing Kathy’s hours on one of the
tasks or by allowing her to work a small amount of overtime. By using the scroll bar, you can view information for other resources. If you scroll down to look at Mary’s resource allocation information and scroll to the right to reveal June and July, you can see that overlapping the design and implementation tasks may have caused another overallocation problem. To fix the problem, you can have Mary work overtime, assign another resource to help, or reschedule the implementation task to reduce the overlap. You can also see if resource leveling, as described in the next section, will help solve the problem.

Resource Leveling

Resource leveling is a technique for resolving resource conflicts by delaying tasks. Resource leveling also creates a smoother distribution of resource usage. You can find detailed information on resource leveling in Chapter 9, Project Human Resources Management, and in Project 2002 Help.

To use resource leveling:

1. **Reopen the baseline file.** Click **Open** and select **baseline.mpp**. Right-click the **Select All** button and click **Entry**. Move the split bar to see more of the Gantt chart. Notice that the project completion date is 9/19/05.

2. **Open the Resource Leveling dialog box.** Click **Tools** on the menu bar, and then click **Level Resources**. The Resource Leveling dialog box opens, as shown in Figure A-55. Uncheck the **Level only within available slack** option, if necessary.
3. **Level the file and review the date changes.** Click the **Level Now** button. In this example, resource leveling moved the project completion date from 9/19 to 9/22, as shown on the Gantt chart milestone symbol for Task 44, Project completed.

4. **View Kathy’s Resource Graph again.** Click the **Resource Graph** icon on the View bar. Notice that Kathy is still overallocated in April.

5. **Level using the Hour by Hour option.** Click **Tools** on the menu bar, and then click **Level Resources**. Change the basis for leveling from Day by Day to **Hour by Hour**, click the **Level Now** button, keep the default option of Entire pool in the Level Now dialog box, and then click **OK**. Notice that Kathy’s overallocation disappears. Use the scroll arrows to reveal information about Mary. Remember that the left pane displays different resources, and the right pane reveals the resource histogram over time. Mary’s overallocations are also gone, as a result of this resource leveling.

6. **View the Gantt chart again.** Click the **Gantt Chart** icon on the View bar and move the split bar to review the Gantt chart, if necessary. The project completion date has been moved back to 9/26 as a result of the resource leveling.

7. **View the Leveling Gantt chart.** Click **View** on the menu bar, click **More Views**, and double-click **Leveling Gantt**. Click **Zoom Out**, if necessary, to adjust the timescale to show quarters and months, and use the horizontal scroll bar to reveal all the symbols on the Leveling Gantt chart, until your screen resembles Figure A-56. Project 2002 adds a green bar to the Gantt chart to show leveled tasks.

![Figure A-56. Leveling Gantt Chart View](image-url)
8. **Save the file as level.mpp.** Click **File** on the menu bar, click **Save As**, and name the file **level.mpp**. Close the file.

If you want to undo the leveling, immediately select *Undo* from the Standard toolbar. Alternatively, return to the Resource Leveling dialog box, and click the *Clear Leveling* button.

If you want to check your work, a copy of level.mpp is available on the companion Web site for this text or from your instructor.

Consult the Project 2002 Help feature and use the key word “level” for more information on resource leveling. Also, be careful when setting options for this feature, so that the software adjusts resources only when it should. For example, the end date for the Project Tracking Database project was pushed back because you set the leveling options to allow the dates to slip. In this case, the project manager might prefer to ask her team to work a little overtime to remain on schedule.

Now that you have learned how to change resource calendars, view resource histograms, and level resources, you are ready to learn how to use Project 2002 to assist in project communications management.

**PROJECT COMMUNICATIONS MANAGEMENT**

Project 2002 can help you generate, collect, disseminate, store, and report project information. There are many different tables, views, and reports to aid in project communications, as you have seen in the previous sections. This section highlights some common reports and views. It also describes how to use templates and insert hyperlinks from Project 2002 into other project documents, how to save Project 2002 files as Web pages, and how to use Project 2002 in a workgroup setting.

**Common Reports and Views**

To use Project 2002 to enhance project communications, it is important to know when to use the many different ways to collect, view, and display project information. Table A-5 provides a brief summary of Project 2002 features and their functions, which will help you understand when to use which feature. Examples of most of these features are provided as figures in this appendix.

You can see from Table A-5 that many different reports are available in Project 2002. The overview reports provide summary information that top management might want to see, such as a project summary or a report of milestone tasks. Current activities reports help project managers stay abreast of and control project activities. The reports of unstarted tasks and slipping tasks alert...
project managers to problem areas. Cost reports provide information related to the cash flow for the project, budget information, overbudget items, and earned value management. Assignment reports help the entire project team by providing different views of who is doing what on a project. You can see who is overallocated by running the Overallocated Resources report or by viewing the two workload reports. You can also create custom reports based on any project information you have entered into Project 2002.

Table A-5: Functions of Project 2002 Features

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gantt Chart view, Entry table</td>
<td>Enter basic task information</td>
</tr>
<tr>
<td>Network Diagram view</td>
<td>View task dependencies and critical path graphically</td>
</tr>
<tr>
<td>Schedule table</td>
<td>View schedule information in a tabular form</td>
</tr>
<tr>
<td>Cost table</td>
<td>Enter fixed costs or view cost information</td>
</tr>
<tr>
<td>Resource Sheet view</td>
<td>Enter resource information</td>
</tr>
<tr>
<td>Resource Information and Gantt Chart split view</td>
<td>Assign resources to tasks</td>
</tr>
<tr>
<td>Save Baseline</td>
<td>Save project baseline plan</td>
</tr>
<tr>
<td>Tracking toolbar</td>
<td>Enter actual information</td>
</tr>
<tr>
<td>Earned Value table</td>
<td>View earned value information</td>
</tr>
<tr>
<td>Resource Graph</td>
<td>View resource allocation</td>
</tr>
<tr>
<td>Resource Usage</td>
<td>View detailed resource usage</td>
</tr>
<tr>
<td>Resource Management</td>
<td>View resource usage and Gantt chart to find toolbar</td>
</tr>
<tr>
<td>Resource Leveling</td>
<td>Level resources</td>
</tr>
<tr>
<td>Overview Reports</td>
<td>Project summary, Top-Level Tasks, Critical Tasks, Milestones, Working Days</td>
</tr>
<tr>
<td>Current Activities Reports</td>
<td>Unstarted Tasks, Tasks Starting Soon, Tasks In Progress, Completed Tasks, Should Have Started Tasks, Slipping Tasks</td>
</tr>
<tr>
<td>Cost Reports</td>
<td>Cash Flow, Budget, Overbudget Tasks, Overbudget Resources, Earned Value</td>
</tr>
<tr>
<td>Assignments Reports</td>
<td>Who Does What, Who Does What When, To-Do List, Overallocated Resources</td>
</tr>
<tr>
<td>Workload Reports</td>
<td>Task Usage, Resource Usage</td>
</tr>
<tr>
<td>Custom Reports</td>
<td>Allows customization of each type of report</td>
</tr>
<tr>
<td>Save As Web page</td>
<td>Save files as HTML documents</td>
</tr>
<tr>
<td>Insert Hyperlink</td>
<td>Inserts hyperlinks to other files or Web sites</td>
</tr>
</tbody>
</table>
Using Templates and Inserting Hyperlinks and Comments

Chapter 10, Project Communications Management, and several other chapters provide examples of templates that you can use to improve project communications. Because it is often difficult to create good project plans, some organizations, such as Northwest Airlines, Microsoft, and various government agencies, keep a repository of sample Project 2002 files. Project 2002 includes several templates.

To access the Project 2002 templates:

1. Open the General templates dialog box. Open level.mpp, if necessary, click File on the menu bar, and then click New to display the New Project Task pane, as shown in Figure A-57.

   ![Figure A-57. Accessing Template Files](image)

2. Open the Templates dialog box. Click the General Templates link below the New from Template section in the New Project Task pane. The Templates dialog box is displayed. Click the Project Templates tab, as shown in Figure A-58. As you can see, there are many templates available. You can also access additional templates from the Templates on Microsoft.com link from the New Project Task pane, from other Web sites, or from your own organization. See Appendix D of this text for information on templates.
3. **Open the Microsoft Office Templates Gallery.** Click **Cancel** in the Templates dialog box, click the **Templates on Microsoft.com** link from the New Project Task pane, and then click **United States** (or the appropriate country for you) on Microsoft’s Tools on the Web page to go to the Template Gallery, as shown in Figure A-59. Your screen may vary based on the templates Microsoft is providing now.

4. **Close your browser and the level.mpp file.**
Using templates can help you prepare your project files, but be careful to address the unique needs of your project and organization. For example, even though the Home Move template file can provide guidance in preparing a Project 2002 file for a specific home move project, you need to tailor the file for your particular situation and schedule. You can also create your own Project 2002 templates by saving your file as a template using the Save As option from the File menu. Simply change the Save As Type option to Template. Project 2002 then gives the file an .mpt extension to identify the file as a template (Microsoft Project Template).

In addition to using templates for Project 2002 files, it is helpful to use templates for other project documents and insert hyperlinks to them from Project 2002. For example, your organization might have templates for meeting agendas, project charters, status reports, and project plans. See Appendix D and the companion Web site for examples of other template files. Next, you will create hyperlinks to some template files created in other applications.

To insert a hyperlink within a Project 2002 file:

1. **View the Entry table.** Open the baseline.mpp file. Right-click the Select All button and click **Entry** to return to the Entry table view.
2. **Select the task in which you want to insert a hyperlink.** Click the Task Name for Task 2, **Kickoff meeting.**
3. **Open the Insert Hyperlink dialog box.** Click **Insert** on the menu bar, and then click **Hyperlink**. Alternatively, you can right-click the task name and select **Hyperlink...** The Insert Hyperlink dialog box opens, as shown in Figure A-60. You may have different folders visible based on your computer’s directory structure.

![Figure A-60. Insert Hyperlink Dialog Box](image-url)
4. Enter the filename of the hyperlink file. Select the **Browse for File** icon to browse for the kickoffmeeting.doc file you downloaded from the companion Web site for this text, as shown in Figure A-60. Double-click on the kickoffmeeting.doc file, and then click **OK**.

5. **Reveal the Indicators column.** Click **Insert** on the menu bar, and then click **Column**. Click the **Field Name** drop-down list, click **Indicators**, and then click **OK**. A Hyperlink icon should appear in the Indicators column to the left of the Task Name for Task 2. Move your mouse over the hyperlink icon until the mouse pointer changes to the Hand symbol to reveal the name of the hyperlinked file, as shown in Figure A-61.

![Figure A-61. Hyperlink Indicator](image)

Clicking the Hyperlink icon in the Indicators column will automatically open the hyperlinked file. Using hyperlinks is a good way to keep all project documents organized.

It is also a good idea to insert notes or comments into Project 2002 files to provide more information on specific tasks.
To insert a note for Task 3:

1. **Open the Task Information dialog box for Task 3.** Open *baseline.mpp*, if necessary, and then double-click the Task Name for Task 3, **Develop Project Charter**. Click the **Notes** tab.

2. **Enter your note text.** Type “The charter was developed as a joint effort.” in the Notes text box, as shown in Figure A-62.

![Figure A-62. Task Information Dialog Box Notes Tab](image)

3. **See the resulting Notes icon.** Click **OK** to enter the note, and notice the Notes icon in the Indicators column next to Task 3.

4. **Open the note.** Double-click the **Notes** icon in the Indicators column for Task 3 to view the note, and then click **OK**.

5. **Close the file without saving it.** Click **File** on the menu bar, and then click **Close**. Click **No** when you are prompted to save the file.

### Saving Files as Web Pages

Many organizations use the Web to disseminate information to employees and to communicate with customers. Project 2002 includes a feature that enables you to save project information as a Web page. As with most Microsoft applications, this feature in Project 2002 is available by selecting Save As Web Page from the File menu. You can create Web pages in several standard formats,
including Compare to Baseline, Cost Data By Task, Earned Value Information, Top Level Tasks List, a “Who Does What” Report, and more. You can also design your own formats for information to be saved as Web pages.

To save project information as a Web page:

1. Open the Save As dialog box for Web pages. Open baseline.mpp. Click File on the menu bar, and then click Save As Web Page.
2. Name the Web page file. Type taskinfo in the File name text box as the new filename, and then click Save and save the file to your Data Disk or hard drive. The Export Wizard dialog box appears. Click Next to go to the next step of the Export Wizard, click the option to Use existing map, and then click Next, so your screen resembles Figure A-63.

![Figure A-63. Export Wizard — Map Selection Dialog Box](image)

3. Select the Import/export map. Click Default Task Information from the Import/export map list, and then click Finish. Project 2002 saves an HTML version of task information from baseline.mpp. The name of the new Web page is taskinfo.html.
In order to see the new Web page, you must open the new HTML file you created.

To open the taskinfo.html file:

1. **Open Windows Explorer.** Click **Start** on the Windows taskbar, select **Programs** (or **All Programs** in Windows XP), then **Accessories**, and then click **Windows Explorer.** Navigate your folders to find the taskinfo.html file. You can also use other methods to open Windows Explorer or use My Computer to find the desired file. Alternatively, start your Web browser, and use the Open Page feature from the File menu to open the file.

2. **Open the taskinfo.html file in your Web browser.** Double-click **taskinfo.html** to open it in your Web browser. The file extension for the file may not appear, depending on your settings. Figure A-64 shows part of the taskinfo.html file in Microsoft Internet Explorer.

![Project Tracking Database](image)

**Project Tracking Database**

**Project Start Date: Mon 4/4/05**  
**Project Finish Date: Mon 9/19/05**

**Task Data**

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>Duration</th>
<th>Start Date</th>
<th>Finish Date</th>
<th>Predecessors</th>
<th>Resource Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Initiating</td>
<td>10 25 days</td>
<td>Mon 4/4/05</td>
<td>Mon 4/18/05</td>
<td></td>
<td>Kathy, John</td>
</tr>
<tr>
<td>2</td>
<td>Kickoff meeting</td>
<td>2 hrs</td>
<td>Mon 4/4/05</td>
<td>Mon 4/4/05</td>
<td></td>
<td>Kathy[50%], Joe[10%]</td>
</tr>
<tr>
<td>3</td>
<td>Develop project charter</td>
<td>10 days</td>
<td>Mon 4/4/05</td>
<td>Mon 4/18/05</td>
<td>2</td>
<td>Kathy[50%], Joe[10%]</td>
</tr>
<tr>
<td>4</td>
<td>Charter agreed</td>
<td>0 days</td>
<td>Mon 4/18/05</td>
<td>Mon 4/18/05</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Planning</td>
<td>95 days</td>
<td>Mon 4/18/05</td>
<td>Mon 8/29/05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Develop project plans</td>
<td>3 weeks</td>
<td>Mon 4/18/05</td>
<td>Mon 5/9/05</td>
<td>4</td>
<td>Kathy[50%], Joe[20%], Mary [20%], Chris[20%]</td>
</tr>
<tr>
<td>7</td>
<td>Review project plans</td>
<td>4 months</td>
<td>Mon 5/9/05</td>
<td>Mon 8/29/05</td>
<td>6</td>
<td>Kathy[50%]</td>
</tr>
</tbody>
</table>

![Figure A-64. Default Task Information HTML File](image)

3. **Close the taskinfo.html file and exit Project 2002.** Click **Close** to close your browser, and then go back to your Project 2002 window and exit Project 2002 without saving the baseline file.
There are several ways to change or customize the standard HTML documents in Project 2002. The Export Wizard allows you to change formats for existing maps, and you can also create your own map. Consult the Project 2002 Help topic “HTML” to find more information on HTML features of Project 2002 and saving your files as Web pages.

Saving project information as Web pages includes text and numerical information, but not graphic information. You can create Web displays of graphic views, such as Gantt charts or network diagrams, but the process requires knowledge of how to include images in Web pages. For detailed information on working with graphic views, see the Project 2002 online Help topic “Copy a Microsoft Project picture into another program or a Web page.” If Web users have Project 2002 loaded on their local PCs, you can share Project 2002 files over the Web by creating a hyperlink to the Project 2002 file stored on a Web server.

Recall that this appendix uses Project 2002 Standard. The Microsoft Solution for Enterprise Project Management includes many features to make it easy to share project information over the Internet. Consult Microsoft’s Web site on Project 2002 for more information.

As you can see, Project 2002 is a very powerful tool. If used properly, it can greatly help users successfully manage projects.

CLOSING CASE

Terry Dunlay was amazed at how much you could do with Project 2002. She could see that it was important to understand several project management concepts before using the software. For example, she had to look up information on creating WBSs, critical path analysis, resource leveling, and earned value management to understand what she was doing with Project 2002. Kathy Nelson was pleased to see how quickly Terry learned to use the software. She asked Terry if she would like to help her on her next project, and Terry was thrilled to have the opportunity to learn even more.

DISCUSSION QUESTIONS

1. What are some of the main differences between Project 2002 and previous versions of Microsoft Project?
2. How do you use Project 2002 to create a WBS hierarchy?
3. Summarize how you use Project 2002 to assist in time management. How do you enter durations, link tasks, and view critical path information?

4. How can Project 2002 assist you in project cost management? How do you enter fixed costs? How do you enter resources and assign them to tasks? How can you view earned value information?

5. Briefly describe how to change resource calendars, view resource histograms, and level resources.

6. Summarize different ways to communicate information with Project 2002. How do you link to other files from within your Project 2002 file? How can you use templates and share information on the Web?

**Suggested Readings**

   
   *This book walks you through step-by-step tutorials on how to use Project 2002 on one continuous running case. It includes six tutorials on Planning a Project, Creating a Project Schedule, Communicating Project Information, Assigning Resources and Costs, Tracking Progress and Closing a Project, and Sharing Information Across Projects, Applications, and the World Wide Web. There are review activities and several cases for each chapter. There are also supporting files and other information on the publisher’s Web site at www.course.com.*

   
   *This comprehensive text (754 pages) includes detailed information on how to use Project 2002. It also includes a CD-ROM with links to Microsoft Project partners, including several sample files and demo products.*

   
   *This text includes detailed coverage of Project 2002 Standard, Professional, Server, and Web Access. It includes 1200 pages of text and additional information on Que’s Web site. Tim Pyron is a Microsoft Project consultant and trainer and editor of Woody's Project Watch, a free newsletter for Project users (www.woodyswatch.com).*

   
   *This text includes 963 pages of text and a CD-ROM with an HTML interface, a collection of Microsoft add-ins and utilities, and a complete eBook for easy browsing and printing.*

---

**Information Technology Project Management, Third Edition**

Kathy Schwalbe

0-619-15984-7

Copyright 2006 Thomson Course Technology. All rights reserved.
EXERCISES

The more you practice using the different features of Project 2002, the more quickly you will master the application and be able to use it to manage projects. This section includes exercises based on three examples of information technology projects that could benefit from using Project 2002 to assist in project scope, time, cost, human resource, and communications management. It also includes an exercise you can use to apply Project 2002 on a real project. There are simpler exercises that use Project 2002 at the end of several other chapters in this text. You can also re-create several screen shots in this text to practice your skills, or you can open and then make slight changes to template files or the files that come with this text.

Exercise A-1: Web Site Development

A nonprofit organization would like you to lead a Web site development project for them. The organization has Internet access that includes space on a Web server, but has no experience developing Web pages or Web sites. In addition to creating their Web site, they would like you to train two people on their staff to do simple Web page updates. The organization wants their Web site to include the following basic information, as a minimum: description of the organization (mission, history, and recent events), list of services, and contact information. They want the Web site to include graphics (photographs and other images) and have an attractive, easy-to-use layout.

1. Project Scope Management

   Create a WBS for this project and enter the tasks in Project 2002. Create milestones and summary tasks. Assume that some of the project management tasks you need to do are similar to tasks from the Project Tracking Database example. Some of the specific analysis, design, and implementation tasks will be to:

   a. Collect information on the organization in hardcopy and digital form (brochures, reports, organization charts, photographs, and so on).

   b. Research Web sites of similar organizations.

   c. Collect detailed information about the customer’s design preferences and access to space on a Web server.

   d. Develop a template for the customer to review (background color for all pages, position of navigation buttons, layout of text and images, typography, including basic text font and display type, and so on).

   e. Create a site map or hierarchy chart showing the flow of Web pages.
f. Digitize the photographs and find other images for the Web pages; digitize hard-copy text.
g. Create the individual Web pages for the site.
h. Test the pages and the site.
i. Implement the Web site on the customer’s Web server.
j. Get customer feedback.
k. Incorporate changes.
l. Create training materials for the customer on how to update the Web pages.
m. Train the customer’s staff on updating the Web pages.

2. Project Time Management
   a. Enter realistic durations for each task, and then link the tasks as appropriate. Be sure that all tasks are linked (in some fashion) to the start and end of the project. Assume that you have four months to complete the entire project. (Hint: Use the Project Tracking Database as an example.)
   b. Print the Gantt Chart view and Network Diagram view for the project.
   c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management
   a. Assume that you have three people working on the project, and each of them would charge $20 per hour. Enter this information in the Resource Sheet.
   b. Estimate that each person will spend an average of about five hours per week for the four-month period. Assign resources to the tasks, and try to make the final cost in line with this estimate.
   c. Print the budget report for your project.

4. Project Human Resource Management
   a. Assume that one project team member will be unavailable (due to vacation) for two weeks in the middle of the project. Make adjustments to accommodate this vacation so that the schedule does not slip and the costs do not change. Document the changes from the original plan and the new plan.
   b. Use the Resource Usage view to see each person’s work each month. Print a copy of the Resource Usage view.

5. Project Communications Management
   a. Print a Gantt chart for this project. Use a timescale that enables the chart to fit on one page.
   b. Print a “To-do List” report for each team member.
Exercise A-2: Software Training Program

ABC Company has 50,000 employees in its headquarters. The company wants to increase employee productivity by setting up an internal software applications training program for its employees. The training program will teach employees how to use software programs such as Windows, Word, Excel, PowerPoint, Access, and Project 2002. Courses will be offered in the evenings and on Saturdays and will be taught by qualified volunteer employees. The instructors will be paid $40 per hour. In the past, various departments sent employees to courses offered by local vendors during company time. In contrast to local vendors’ programs, this internal training program should save the company money on training as well as make its people more productive. The Human Resources department will manage the program, and any employee can take the courses. Employees will receive a certificate for completing courses, and a copy of the certificate will be put in their personnel files. The company has decided to use off-the-shelf training materials, but is not sure which vendor’s materials to use. The company needs to set up a training classroom, survey employees on what courses they want to take, find qualified volunteer instructors, and start offering courses. The company wants to offer the first courses within six months. One person from Human Resources is assigned full-time to manage this project, and top management has pledged its support of the project.

1. Project Scope Management

Create a WBS for this project and enter the tasks in Project 2002. Create milestones and summary tasks. Assume that some of the project management tasks you need to do are similar to tasks from the Project Tracking Database example. Some of the tasks specific to this project will be to:

a. Review off-the-shelf training materials from three major vendors and decide which materials to use.

b. Negotiate a contract with the selected vendor for their materials.

c. Develop communications information about this new training program. Disseminate the information via department meetings, e-mail, the company’s intranet, and fliers to all employees.

d. Create a survey to determine the number and type of courses needed and employees’ preferred times for taking courses.

e. Administer the survey.

f. Solicit qualified volunteers to teach the courses.

g. Review resumes, interview candidates for teaching the courses, and develop a list of preferred instructors.
h. Coordinate with the facilities department to build two classrooms with twenty personal computers in each, a teacher station, and an overhead projection system (assume that the facilities department will manage this part of the project).

i. Schedule courses.

j. Develop a fair system for signing up for classes.

k. Develop a course evaluation form to assess the usefulness of each course and the instructor’s teaching ability.

l. Offer classes.

2. Project Time Management
   a. Enter realistic durations for each task and then link appropriate tasks. Be sure that all tasks are linked in some fashion to the start and end of the project. Use the Project Tracking Database as an example. Assume that you have six months to complete the entire project.

   b. Print the Gantt Chart view and Network Diagram view for the project.

   c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management
   a. Assume that you have four people from various departments available part-time to support the full-time Human Resources person, Terry, on the project. Assume that Terry’s hourly rate is $40. Two people from the Information Technology department will each spend up to 25 percent of their time supporting the project. Their hourly rate is $50. One person from the Marketing department is available 25 percent of the time at $40 per hour, and one person from Corporate is available 30 percent of the time at $35 per hour. Enter this information about time and hourly wages into the Resource Sheet. Assume that the cost to build the two classrooms will be $100,000, and enter it as a fixed cost.

   b. Using your best judgment, assign resources to the tasks.

   c. View the Resource Graphs for each person. If anyone is overallocated, make adjustments.

   d. Print the budget report for the project.

4. Project Human Resource Management
   a. Assume that the marketing person will be unavailable for one week, two months into the project, and for another week, four months into the project. Make adjustments to accommodate this unavailability, so the schedule does not slip and costs do not change. Document the changes from the original plan and the new plan.

   b. Add to each resource a 5 percent raise that starts three months into the project. Print a new budget report.

   c. Use the Resource Usage view to see each person’s work each month. Print a copy.
5. Project Communications Management
   a. Print a Gantt chart for this project. Use a timescale that enables the chart to fit on one page.
   b. Print a “To-do List” report for each team member.
   c. Create an HTML document using the “Default task information” map. Print it from your Web browser.

Exercise A-3: Project Tracking Database

Expand the Project Tracking Database example. Assume that XYZ Company wants to create a history of project information, and the Project Tracking Database example is the best format for this type of history. The company wants to track information on twenty past and current projects and wants the database to be able to handle 100 projects total. It wants to track the following project information:

- Project name
- Sponsor name
- Sponsor department
- Type of project
- Project description
- Project manager
- Team members
- Date project was proposed
- Date project was approved or denied
- Initial cost estimate
- Initial time estimate
- Dates of milestones (for example, project approval, funding approval, project completion)
- Actual cost
- Actual time
- Location of project files
1. Project Scope Management

Open scope.mpp and add more detail to Executing tasks, using the information in Table A-6.

**Table A-6: Company XYZ Project Tracking Database Executing Tasks**

<table>
<thead>
<tr>
<th>ANALYSIS TASKS</th>
<th>DESIGN TASKS</th>
<th>IMPLEMENTATION TASKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect list of 20 projects</td>
<td>Gather detailed requirements for desired outputs from the database</td>
<td>Enter project data</td>
</tr>
<tr>
<td>Gather information on projects</td>
<td>Create fully attributed, normalized data model</td>
<td>Test database</td>
</tr>
<tr>
<td>Define draft requirements</td>
<td>Create list of edit rules for fields, queries, and default values, and format reports about projects masks for data</td>
<td>Make adjustments, as needed</td>
</tr>
<tr>
<td>Create entity relationship diagram for database</td>
<td>Develop list of queries required for database</td>
<td>Conduct user testing</td>
</tr>
<tr>
<td>Create sample entry screen</td>
<td>Review design information with customer</td>
<td>Make adjustments based on user testing</td>
</tr>
<tr>
<td>Create sample report</td>
<td>Make adjustments to design based on customer feedback</td>
<td>Create online Help, user manual, and other documentation</td>
</tr>
<tr>
<td>Develop simple prototype of database</td>
<td>Create full table structure in database prototype</td>
<td>Train users on the system</td>
</tr>
<tr>
<td>Review prototype with customer</td>
<td>Create data input screens</td>
<td></td>
</tr>
<tr>
<td>Make adjustments based on customer feedback</td>
<td>Write queries</td>
<td></td>
</tr>
<tr>
<td>Create reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create main screen</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Review new prototype with customer</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2. Project Time Management
   a. Enter realistic durations for each task, and then link appropriate tasks. Make the additional tasks fit the time estimate: 20 days for analysis tasks, 30 days for design tasks, and 20 days for implementation tasks. Assume that all of the executing tasks have a total duration of 70 days. Do not overlap analysis, design, and implementation tasks.
   b. Print the Gantt Chart view and Network Diagram view for the project.
   c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management
   a. Use the resource and cost information provided in resource.mpp.
   b. Assign resources to the new tasks. Try to make the final cost about the same as that shown in the Project Tracking Database example: about $50,000.
   c. Print the budget report for the project.

4. Project Human Resources Management
   a. Two months after the project begins, give everyone on the team a 10 percent raise. Document the increase in costs that these raises cause.
   b. Use the Resource Usage view to see each person’s work each month. Print a copy of the Resource Usage view.

5. Project Communications Management
   a. Print a Gantt chart for this project. Use a timescale that enables the chart to fit on one page.
   b. Print a “Top-Level Tasks” report.
   c. Create a “Cost Data by Task” HTML document. Print it from your Web browser.

Exercise A-4: Real Project Application

If you are doing a group project as part of your class or for a project at work, use Project 2002 to create a detailed file describing the work you plan to do. Enter a sufficient WBS, estimate task durations, link tasks, enter resources and costs, assign resources, and so on. Then save your file as a baseline and track your progress. View earned value information when you are about halfway done with the project or course. Export the earned value information into Excel and create an Earned Value Chart. Continue tracking your progress until the project or course is finished. Print your Gantt chart, Resource Sheet, Project Summary report, and relevant information. In addition, write a two- to three-page paper describing your experience. What did you learn about Project 2002
from this exercise? What did you learn about managing a project? How do you think Project 2002 helps in managing a project? You may also want to interview people who use Project 2002 and ask them about their experiences and suggestions.

**RUNNING CASES**

Review the running cases provided in Appendix C. Several questions involve using Project 2002.